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1Getting Started
Welcome to PREMIER+ ECQ™, the software that helps you create wonderful drawings for 
embroideries, quilting and cutter designs. Work with clipart images or create your own 
designs using a background picture. Turn these drawings into embroideries and see them 
on the screen exactly as you will sew them. 

Creating Pictures
Create your pictures using the drawing tools and Gallery designs. Save drawings or 
pictures or Export them as embroideries, quilting designs, and for your cutting machine.

The Freehand, Point and Bezier Draw features allow you to work in detail. Draw an outline, 
place points, or draw Bezier curves freely or over a picture to create your design.

Design Choices
Adjust designs using easy editing features: Navigate around the design with the Filmstrip. 
Grouping features allow you to keep smaller parts of your design together. Export your 
design when ready.

Finding Information

Reference Guide
The Reference Guide shows how to start the software and provides a quick tour of the 
main screen. This is followed by information on key features, together with short ’How-To’ 
examples, which will help you learn how to use the your software. The Reference Guide 
additionally contains full reference information. The Reference Guide is supplied in PDF 
format , ready for printing. You can download it from www.premierplusecq.com/

To view and print the PDF Guides, you will need a PDF reader such as Windows® Reader (included in 
Windows® 10 and 8) or Adobe® Reader (available from adobe.com).

Tooltips and Online Help
To learn the name of a function, position the arrow pointer over its icon. A tooltip with the 
function name will appear.

The online help contains the ’How-To’ examples and full reference information. Use the 
Help icon , press F1 or click the Help button. Where available, a help topic will appear 
that is relevant to the item where help was requested.

Inspiration and Support
The Inspiration and Support option on the Help tab connects to a website with 
information on PREMIER+ ECQ™, and the answers to frequently asked questions. 
www.premierplusecq.com/
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Where to Start
Starting PREMIER+ ECQ™

Windows® 10; Windows® 8 Start Screen
1 At the bottom left of your computer screen, open the Windows® 10 or Windows® 8 Start Screen.
2 Type "Prem" and the Search Screen will appear.
3 Ensure Apps is selected.
4 Click on PREMIER+ ECQ™  to launch it.

Windows® 7 Start Menu
1 Click the Start button at the bottom left of your computer screen and the Start menu appears.
2 Move the arrow pointer to All Programs and another menu will appear.
3 Move the arrow pointer to PREMIER+ ECQ™.
4 Click on PREMIER+ ECQ™  to launch it.

Shortcuts
An alternative to the Start screen/menu method described previously is to use a Shortcut 
to PREMIER+ ECQ™. This is created automatically during the installation process.

Windows® 10 (Start Screen); Windows® 8 
1 Click on the PREMIER+ ECQ™  tile in the Start Screen.

Windows® 10 (Desktop); Windows® 7 
1 Close or minimize any programs you have running.
2 Double-click on the Shortcut to the PREMIER+ ECQ™ folder.
3 Double-click on PREMIER+ ECQ™  to launch it.

Closing PREMIER+ ECQ™

Exit
Ends the PREMIER+ ECQ™ session. You can also use the Close command on the PREMIER+ 
ECQ™ Control menu.

Shortcuts
�  Mouse: Click the Close icon  on the title bar or double-click the Control menu box.
�  Keys: Alt + F4

About PREMIER+ ECQ™
Access via the Help tab. The version number of PREMIER+ ECQ™ is given here. You will 
need this if you contact technical support at any time.

Shortcut
�  Keys: Alt, H, A
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Parts of the Software Window
Title Bar 
The title bar at the top of the window is highlighted if 
PREMIER+ ECQ™ is active. The Quick Access toolbar gives icons 
for the following frequently used features: Insert, Save, Save As, Undo, Redo. 

If more than one instance of PREMIER+ ECQ™ is open, each open window will show the 
name of the drawing file.

Ribbon Bar
There are 7 tabs on the ribbon: File, Draw, Insert, Multiply, Export, View and Help.

An alternative way to access ribbon options is to press the Alt key, then the highlighted letter of the tab, 
followed by the highlighted letter of the tab item, e.g. Alt, D, CC to Copy the selected object. Some functions 
are available by pressing the Ctrl key and another key at the same time. These shortcuts are shown in the 
tooltip for the relevant function.
Use the Draw tab to select, copy and Group parts of a design; and to create holes in filled 
shapes.

Use the Insert tab to add Shapes, Lettering and Designs to your drawing.

Use the Multiply tab to repeat drawings or actions automatically by reflecting across and/
or down, and by rotating. 

Use the Export tab to save your design as a picture, an embroidery, a design for a quilting 
robot, or for a cutter.

Use the View tab to adjust the Grid, measure the design, and show and fade the 
background picture.

Select part or all of the drawing
Group or Ungroup the selected objects

Make and Uncombine Holes

Cut, copy, paste or delete the selected objects

Snap to Grid or Line
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Draw Window

Use the Draw window to load or create a vector drawing for your design. Modify a drawing 
as desired, or make your own drawing. You can also load a raster image to use as a 
background. The Draw window contains a FilmStrip to the left and design panel to the 
right of the Canvas, in addition to the ribbon tab. 

The Draw tab has tools for copying, selecting, combining and grouping objects.

FilmStrip
To the left of the Canvas is the FilmStrip. The FilmStrip displays the objects such as the 
lines, fills and groups in the drawing, and enables you to move objects within the drawing.

Design Panel
To the right of the Canvas is the design panel. At the top are the line and fill colors, each 
giving access to a color palette of 40 common colors, and the Colors dialog which enables 
you to use many more colors. 

The middle section has tools for drawing and editing pictures. The tool options change 
according to the drawing tool being used.

Quick Access Toolbar Ribbon Bar Tabs Ribbon Bar Title Bar

Canvas

Design Panel

FilmStrip Status Bar
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FilmStrip
Use the FilmStrip to view the numbered sequence of 
objects, select objects, change the sequence of objects, 
and delete objects.

Design Panel
The Design Panel contains the color worksheet, notes 
and settings for the design, and the Clipboard and 
Overview window.

Title Bar
The title bar at the top of the window is highlighted if 
PREMIER+ ECQ™ is active. The title bar shows the 
program name and the name of the currently loaded 
drawing.

Canvas
The Canvas is the area where the picture is displayed 
and edited, and the design is created and edited.

Status Bar
The status bar is found at the bottom of each window. 
Starting from the left, the status bar shows:

• The zoom tools.
• The Zoom Bar.

Group Object Layout
Order

Scroll
Bar
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PREMIER+ ECQ™ Terms and Conventions
On-screen Pointers
The pointer is most commonly shown as an arrow  on the screen.

If it is positioned over a text box it changes to an I-bar  and you can type, such as the Edit 
Notes dialog box in the Design Panel.

If Zoom To Rectangle  is chosen, the Zoom In pointer  appears. If the Pan feature is 
used to move around the screen, the Pan cursor  appears. If Get Length  is chosen the 
Measure pointer  appears.

If the Freehand functions are used the pointer becomes a pen . 

If the Point Line functions are chosen the pointer becomes a circle , and when lines are 
drawn with Bezier Draw , the pointer becomes a Bezier Draw pointer . When points 
are converted to Curve the pointer becomes the Convert Points to Curve pointer , and 
when points are converted to Corner points the pointer becomes the Convert Points to 
Corner pointer .

When points on Point Lines or Bezier Lines are adjusted the pointer becomes a small 
cross  (a Move pointer).

When the Pick Line Color  function is selected, the Line eyedropper pointer  
appears. When the Pick Fill Color  function is selected, the Fill eyedropper pointer  
appears.

The Box Select pointer , Freehand Select pointer  or Point Line Select pointer  
appear when the associated Select function is chosen. 

There are several pointers indicating functions in the selection box. The Rotate pointer  
appears when the mouse pointer is over the Rotate handle . The cross-hair pointer  
appears when the mouse is over the center of rotation .

The diagonal double-headed arrow  pointer appears when the mouse pointer is over a 
square corner handle . The horizontal double-headed arrow  pointer appears when 
the mouse pointer is over the Flip Horizontal handle . The vertical double-headed 
arrow  pointer appears when the mouse pointer is over the Flip Vertical handle . The 
horizontal and vertical double-headed arrows also appear when the Skew handles  are 
used. The pointer becomes a four-headed arrow  (a move pointer) when it is over a 
selection box.
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Touch Gestures
Touch gestures are used when viewing and moving drawings in PREMIER+ ECQ™. They are 
available when using a touch-sensitive screen. 

General

Select and move
One finger touch and one finger slide are equivalent to click and drag with a mouse. Use 
to move embroideries, select, draw or create stitches with freehand features, and so on.

Autoscroll
When you drag within a document, the autoscroll feature moves the pointer 
automatically, changing the view of the Canvas. 

This is useful when zoomed in. Use autoscroll while moving or resizing a selected 
embroidery.

�  Use a two finger swipe on the Canvas.

Pinch to zoom
Pinch two fingers to zoom in, and spread two fingers to zoom out.

Context menu
Press and hold and a context-sensitive menu will appear if available (similar to a right-
click). 

File Formats

Picture Files
PREMIER+ ECQ™ can load any of the following drawing file formats: PREMIER+ ECQ™ Files 
(*.ecq), 4D / 5D QuiltDesign Creator 4QB (*.4qb) AND Scalable Vector Graphics (.svg).

PREMIER+ ECQ™ can load the following picture file formats as a background picture: JPEG-
JFIF Compliant (.jpg, .jif, .jpeg) and Portable Network Graphics (.png).

PREMIER+ ECQ™ can save drawings in the PREMIER+ ECQ™ (.ecq) drawing file format.

PREMIER+ ECQ™ can Export a picture in any of the following picture file formats: Scalable 
Vector Graphics (.svg), JPEG Low Quality (.jpg), JPEG High Quality (.jpg) and Portable 
Network Graphics (.png).

Cutter Files
PREMIER+ ECQ™ can Export a cutter file in any of the following cutting file formats: 
Scalable Vector Graphics (.svg), .dxf and .fcm.

Quilting Files
PREMIER+ ECQ™ exports quilting files in the following formats: 4D / 5D QuiltDesign 
Creator 4QB (*.4qb), QuiltSewClever / Quilt Artist / Shirley Stitcher QCC (*.qcc), PC Quilter 
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(*.txt), Statler Stitcher (*.qli), AutoCAD (*.dxf), HPGL (*.plt), CompuQuilter (*.cmd), 
CompuQuilter (*.cqp), Handi Quilter (*.hqf) and IntelliQuilter (*.iqp).

Embroidery File Formats
PREMIER+ ECQ™ exports any of the following embroidery file formats: Husqvarna Viking / 
Pfaff (.vp3), PREMIER+ (.vp4), Brother/Baby Lock/Bernina PES (.pes version 2 - 10), 
Compucon/Singer PSW (.xxx), Janome/Singer (.jef), Melco Expanded (.exp) and Tajima 
(.dst).
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2PREMIER+ ECQ™ Overview

Opening and Inserting
When you start PREMIER+ ECQ™  you can create a new design, or Open or Insert an 
existing design.

Drawing
1 Start PREMIER+ ECQ™ . It opens at the Draw tab.

2 Click Point Draw .
This will draw using the default colors.

3 Place points to create a rough circle.
4 To finish, place the final point on top of the first point.

The pointer changes to a ’x’, and a rough filled shape is created.
5 Place points in a line, and then double-click. A line is created.

You can also finish using the right-click menu.
6 Right-click and choose Finish Point Draw.
7 Click outside the line you just drew.
8 Click the Line color in the Design Panel and choose a new outline color from the palette.

You can also pick a color  from the background picture, set the width of the line, or select No Line .
9 Click the Fill color in the Design Panel and choose a new fill color from the palette.
10 Click Bezier Draw .

You can also use Freehand Draw  with three smoothing options, or load a picture in the View tab with 

Load Background , and then use Trace Line , Trace Area  or Trace Area & Hole  to trace the 
background picture.

11 Click and drag to draw a shape with a Bezier line.
12 To complete the shape, click to place the final Bezier point on top of the first point.

Quick Access Toolbar Ribbon Bar Tabs Ribbon Bar Title Bar

Canvas

Design Panel

FilmStrip Status Bar
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13 Right-click and choose Finish Bezier Draw.
The shape that you just drew is selected. It is using the colors that you chose.

14 Note the colors in the Design Panel, then click to select the first shape that you drew. The colors 
change back to the first set.

15 Click the Line color in the Design Panel. You can now choose a different outline color.

Change the colors for a selected object in the Design Panel. Click outside all objects or use Select None  
when selecting colors for a new object.

16 Click Swap Colors .
In the Design Panel and the selected shape, the Line and Fill colors exchange places. The colors also change 
on the shape in the FilmStrip.

Editing
17 Click Edit Points  to show the points in the selected shape.
18 Then use Insert Points  and Delete Points  to add and remove points from your selected shape.
19 Click Knife .
20 Draw a line straight across the shape that you created with Point Draw .

There is no longer a fill color in the shape, and in the FilmStrip you can see that it is now two lines.
21 Click Object Select , then click on one of the cut lines in the canvas. It is surrounded by a selection 

box.
22 Drag the box a short distance away from the other line.
23 In the Design Panel, click Join . There are round handles on all of the open lines in your design.

You cannot Join closed areas, only open lines.
24 Where you dragged the two lines apart, click one handle on the section of cut line. The handle is 

colored orange.
25 Click the other handle for that section. The lines join.
26 Join the other two handles.
27 Click Edit Points , then click the shape that you created with Bezier lines.
28 Click Convert Points to Corner , and click one of the points. It changes to a Bezier corner point.

If you cut your Bezier shape with the Knife, some of the points may be corner points already and cannot be 
converted.

29 Then click Convert Points to Curve , and click the point to change it back.

You can also convert line types using Convert to Point Line  and Convert to Bezier Line .

Reshaping, Selecting and Grouping
30 Use Select All  followed by Delete  to clear the canvas.
31 Click the Insert tab.
32 In the Shape drop-down list select shape 30, a 

crescent.
33 Click Insert Shape .
34 Use the Mirror Vertical and Mirror Horizontal 

handles to flip the shape.
35 Move the Center of Rotation, and then rotate 

using the Rotate handle.
You can also rotate by set amounts with Rotate 
45  and Transform .

36 Drag the lower Skew handle to skew the crescent horizontally, then skew it vertically with the other 
skew handle.

37 Right-click on the crescent and Delete  it.
38 In the Shape drop-down list select shape 8, an octagon.
39 Click Insert Shape .
40 Hold down the Ctrl and Shift keys, then drag the corner of the selection box to make the octagon 

larger.

Mirror Vertical Handle

Rotate
Handle

Resize
Handle

Skew
Handle

Mirror
Horizontal

Handle

Center of
Rotation
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41 Click Insert Shape  again to place a second octagon on top of the first.
42 Click the Draw tab, then click Box Select , and drag to select both shapes.
43 Click Make Holes . The smaller octagon is now a hole cut in the larger 

one.
44 With the octagon selected, click Uncombine .

There are two octagon shapes again.
45 Click Object Select , then click to select the larger octagon.
46 Hold down the Ctrl and Shift keys, then drag the corner of the selection 

box to reduce the size of the larger octagon.
47 Drag it away from the other octagon.
48 Click the Insert tab, then click inside the Lettering text box.
49 Enter a name in the text box.
50 Click Insert Lettering . The name is placed on the canvas.
51 Move the lettering out of the way of the two octagons.
52 In the FilmStrip, click the ’+’ by the name.

The letters in the name are within a group.
53 Click on the name in the canvas. All of the letters are selected in the FilmStrip.
54 Click on one of the letters in the FilmStrip. That letter is selected individually and can be moved.
55 Click the Draw tab, then click Box Select , and drag to select both octagons.
56 Click Group . The octagons now form a group in the FilmStrip.

57 With the grouped octagons selected, click Ungroup .

Use Ungroup All  to ungroup nested groups.

Multiply
58 Click New Window  on the File menu to open a new Canvas.
59 On the Insert tab, use Design Gallery  to load a flower design.

Here I used Daffodil in the Flower and Leaves folder, then deleted the leaves and resized it.
60 Click the Multiply tab.
61 Ensure that Circle  is selected.
62 Move the design to the top left, then click Enable Multiply . The design is repeated in a circle.
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63 Set the number of repeats to 8, and drag the designs into position.

64 Click Apply Multiply  to finish the Multiply.
You can also multiply designs in a line or within a grid with the Tile option.

Exporting
65 In the Quick Access toolbar, click Save As .
66 Save the drawing.

Use this version if you need to make further adjustments later.
67 Click the Export tab, then click Embroidery with Fills . An embroidery of your design is displayed.

If desired, click the Draw tab and adjust your drawing further - for example, use thicker outlines for a satin 
line border.

68 Click Export  and save your embroidery as a .vp4 file for stitching out.

PREMIER+ ECQ is a trademark of KSIN Luxembourg II, S.a.r.l. 
© 2019 Singer Sourcing Limited LLC. All rights reserved. (Version A)
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3Managing Drawings
You may open drawings with Insert , Open , and open a background picture with 
Open Background Picture .

You can only use Open  when there are no objects in the design. Either use Insert  instead, or click 
File, New Window and then open the drawing.

Insert
Use Insert  to add an existing drawing to the current design. All sections of the design 
will be grouped together, ready for moving, resizing and so on.

PREMIER+ ECQ™ displays the Open dialog so you can choose a drawing to open. You may 
load quilting and vector graphic design files in a variety of formats.

Open a folder, and scroll down and click a drawing to select it. Click OK to load the drawing 
on the Canvas.

File Name
Type or select the filename you want to open.

Files of Type
This is set to ECQ Files (*.ecq).

Look In
Select the drive or folder containing the file that you want to open.

More Options
Switch from list  or details  view to icons with thumbnail images of the drawing. For 
example, Extra Large icons .

Preview Pane
Preview the drawing file before opening .

You can change the icon size, and show the names of the drawings.

Click Open to load the 

Browse to a different folder

Click on a design to select it

Search for a design

Change the view or icon size

selected design
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You may load files in PREMIER+ ECQ™ Files (.ecq), 4D / 5D QuiltDesign Creator 4QB (*.4qb) 
and Scalable Vector Graphics (.svg) formats.

Shortcut
�  Quick Access Toolbar and File Menu: 

Insert a Drawing
1 In the Quick Access toolbar, click Insert . The Open dialog box appears.

Alternatively, click File, Insert .
2 Browse through the drives and folders of the computer to the desired folder.
3 Click on an icon to select the drawing.
4 Click Open to load the drawing into the Canvas.

Alternatively, double-click the icon for the drawing.

Open
Use File, Open  to open an existing picture. PREMIER+ ECQ™ displays the Open dialog 
box so you can choose a drawing to open.

Open a folder, and scroll down and click a drawing to select it. Click OK to load the drawing 
on the Canvas.

File Name
Type or select the filename you want to open.

Files of Type
This is set to ECQ Files (*.ecq).

Look In
Select the drive or folder containing the file that you want to open.

More Options
Switch from list  or details  view to icons with thumbnail images of the drawing. For 
example, Extra Large icons .

Click Open to load the 

Browse to a different folder

Click on a design to select it

Search for a design

Change the view or icon size

selected design
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Preview Pane
Preview the drawing file before opening .

Shortcuts
�  File Menu: 
�  Keys: Ctrl + O

Open a Drawing
1 Click File, Open . The Open dialog appears. 
2 Browse through the drives and folders of the computer to the desired folder.
3 Click on an icon to select the drawing.
4 Click Open to load the drawing into the Canvas.

Alternatively, double-click the icon for the drawing.

Load a Design with Drag and Drop
To drag and drop a drawing (.ecq) file onto the screen, use Windows® Explorer.

Drag a Design to the Canvas
1 In Windows®, open an Explorer window. If required, resize the Explorer window so you can see both 

Explorer and PREMIER+ ECQ™.
In Windows® 10 and 8, click File Explorer on the Status Bar. In Windows® 7, right-click the Start button on 
the Taskbar, then click Explore. 

2 Browse through the drives and folders of your computer to find the folder with your drawings in it.
3 Click on the desired design name or icon to highlight it.
4 Use the mouse to drag and drop the design onto the PREMIER+ ECQ™ screen. The design will be 

displayed on the screen.
5 Close Explorer.

Recent
Open previously used drawing (.ecq) files via the file names in the Recent section of the 
File menu. Select the name of the desired design file.

Recently used designs may only be chosen from the File menu in the Design window. There is no recent files 
list for background pictures.

Shortcut
�  File Menu: Recent

New
Use New  to clear the PREMIER+ ECQ™ screen and create or load a new design. You are 
prompted to save the current design if changes have been made. 

Shortcuts
�  File Menu: 
�  Keys: Ctrl + N
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New Window
Use File, New Window  to open an additional PREMIER+ ECQ™ window so that you can 
start a new design. To move between open PREMIER+ ECQ™ windows, hover over the 
PREMIER+ ECQ™ icon on the taskbar, and select the desired window.

Shortcuts
�  File Menu: 
�  Keys: Ctrl + Shift + N

Save Designs
Use the options on the Export tab to save your design as a picture, an embroidery, a design for a quilting 
robot, or for a cutter. See “Export” on page 72.

Save
Use Save  to save the design file under its current name and folder. When you save a 
design for the first time, PREMIER+ ECQ™ displays the Save As dialog box so you can name 
the design file. To change the name and folder of an existing design file, use Save As.

Shortcuts
�  Quick Access Toolbar; File Menu: 
�  Keys: Ctrl + S; Alt, 2

Save As
Use Save As  to save and name the design file. PREMIER+ ECQ™ displays the Save As 
dialog box so you can name your design. To save a design with its existing file name and 
folder, use the Save command.

Shortcuts
�  Quick Access Toolbar; File Menu: 
�  Keys: Ctrl + Shift + S; Alt, 3
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4Creating a Drawing
A full range of drawing functions is available for vector graphics files (easily resizable 
images using lines, curves and shapes). Use the Draw tab to select, organize and edit your 
drawing.

Use the design panel to select colors, and to draw and edit lines and fill areas.

After drawing lines and areas, use the Multiply feature (see “Multiply” on page 62) to repeat them in your 
drawing.

Select part or all of the drawing
Group or Ungroup the selected objects

Make and Uncombine Holes

Cut, copy, paste or delete the selected objects

Snap to Grid or Line

Swap the line and fill colors

Pick the line color, or set no line

Pick a fill color, or set no fill

Place points or draw a Bezier line

Trace the background picture
Add, remove, or adjust the points in a line 

Convert points in a Bezier line

Align the objects in your drawing

Set the line width

Draw a freehand line, and set the smoothing

Cut or join lines

Convert between Point and Bezier lines

Rotate and transform objects in your drawing
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Choose Drawing Colors
Colors and the Color Palette
Use the Color palette to choose the colors for 
drawing Lines and Fills.

The Color palette provides 40 commonly used 
colors. Click on a color in the palette to place it in 
the Design Panel as the Line or Fill color.

Colors Area
The Colors area at the top of the Design Panel displays the currently selected Line and Fill 
colors. The top color is the Line color and the lower color is the Fill color.

Change a Color in the Colors Area
�  Click the drop-down menu for Line or Fill, then click on a color from the Color palette to 

select it as the Line or Fill color.
�  To choose a color that is not in the Color palette, click More Colors in the palette to bring 

up the Colors dialog box. (After a color is chosen, it will be placed as the Line or Fill color.)
�  To select a color from the picture on the screen use the Pick Line Color  or Pick Fill 

Color  function in the Drawing panel.

Pick Line Color
Use Pick Line Color  to select a color from the picture on the screen and make it the Line 
color in the Color box.

This is useful for choosing colors from the picture for drawing that do not appear in the 
Color palette.

Shortcut

�  Design Panel, Line: 

Pick a Color for Line Color
1 Click Pick Line Color . The pointer changes to an eyedropper .
2 Click the desired color in the drawing or background picture to make it the Line color.

No Line
Use No Line  to draw a fill area with no surrounding line. 

Change the Color

See more colors

Select a color

Change the Color

See more colors

Select a color
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Shortcut
�  Design Panel, Line: 

Line Width 
Select a line width from the drop-down list in the Line section. The 
available widths are 0.5mm and 1, 1.5, 2, 2.5, 3, 3.5, 4, 5, 6, 7, 8, 9 and 
10mm. The default width is 0.5mm.

Swap Colors
Use Swap Colors  to switch the line and fill colors for the selected 
object, or before creating a new object.

Shortcut
�  Design Panel, Line: 

Pick Fill Color
Use Pick Fill Color  to select a color from the picture on the screen, or other objects in 
the drawing,  and make it the color in the Fill color block for drawing. Also use Pick Fill 
Color to change the Fill color for the selected object or objects.

This is useful for choosing colors from the picture for drawing that do not appear in the Color palette.

Shortcut

�  Design Panel, Fill: 

Pick a Color from the Picture for a Fill
1 Click Pick Fill Color . The pointer changes to an eyedropper .
2 Click the desired color in the drawing or background picture to make it the color for the Fill color 

block. 

No Fill
Use No Fill  when you do not want a fill within a closed line. 

Shortcut
�  Design Panel, Fill: 

Change the Color

See more colors

Select a color
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Colors Dialog Box
The Colors dialog box is used to choose a new color for 
the Line or Fill color.

When the Colors dialog box appears, it shows the 
Standard color selection. If desired, click one of the 
Standard colors. A highlight shows the selected color. 
The New/Current box shows the difference between 
the newly chosen color and the color currently used.

Click the Custom tab to be able to select any of the 16 
million RGB colors.

Click in the blended color palette to choose a basic 
color, then use the slider at the side to choose the 
desired brightness level. The HSL and RGB values are 
updated as you change the color and the color is 
previewed in the New/Current box.

You can also directly enter Hue, Sat(uration), 
Lum(inance) (HSL) and/or Red, Green, Blue (RGB) 
values. Alternatively, use the up/down buttons on each 
of the HSL and RGB value boxes to make fine 
adjustments to the color.

Color Models

Hue, Saturation, Luminance (HSL) Color Model
Hue is the color (red, yellow, green, or blue) for the selected color, expressed as a value 
between 0 and 239. Saturation (Sat) is the strength or purity of color in a specified hue. 
This is related to the amount of gray in it and is measured from 0 (completely gray) up to a 
maximum of 240 (no gray). The higher the saturation, the purer or more vivid the color. 
Luminosity (Lum) is the intensity of lightness or darkness in a color, specified by a value 
between 0 (black) and 240 (white). If Saturation is 0, the Luminosity setting specifies a 
shade of gray.

Red, Green, Blue (RGB) Color Model
The RGB model, one of the Additive Color models, is used on computer monitors. It has 
three primary colors — red, green, and blue — that it creates by emitting light. These 
three colors are combined in various proportions to produce all the colors displayed on 
your screen. They are referred to as additive because they combine to produce white. 
Primary colors are measured as a value from 0-255. The colors produced by combining the 
three primaries are a result of the amount of each of those shades present. For example, 
pure red has a red value of 255, a green value of 0, and a blue value of 0. Yellow has a red 
value of 255, a green value of 255, and a blue value of 0. If Red, Green and Blue are set to 
zero, the color is black; if all three are 255, they produce white.
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Changing the Colors for Lines and Fills
You can change line and fill color for the selected block in the Design Panel.

Select a block, and the Line and Fill colors become those for that block. Change the colors, 
then deselect the block.

See “Change Color and Other Properties” on page 51.

Change the Colors for an Existing Line and Fill
1 Click to select a block of objects. The block is surrounded by a box.

The objects can be a variety of colors.
2 Look at the Design Panel, the Line and Fill color are those for the selected block.
3 In the Line section select a color and the width that you want to use, or select No Line .
4 In the Fill section select a color for the Fill or choose No Fill .
5 All of the objects in the block change to your selected color, Line and Fill type.
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Drawing Lines
Freehand Draw
Use Freehand Draw  to draw a line that follows the movement of the pointer. Adjust the 
flow of the line with the smoothness options. Freehand Draw is enabled until another tool 
is selected.

Shortcut
�  Design Panel, Draw 

Draw a Line with Freehand Draw
1 Select the desired line color from the Color palette. Use Pick Color  if you want to select colors 

from the picture.
If you want a fill, also choose a Fill color.

2 Select a line thickness option from the drop-down list in the Lines section.
3 Click the Freehand Draw icon .
4 If desired, change the line smoothness by clicking on the desired setting 

in the Smoothness Options menu.
5 Click and drag across the Canvas from the desired start point to the 

desired end point to draw a line. A line appears showing the freehand line 
as it is drawn. 

6 Lift the pen or release the mouse button and the freehand line is 
completed. Each time you drag and release a new freehand line will be 
drawn, until another feature is selected.

Smoothness Option
When the line is drawn it is converted into points. How smooth the line is will depend on 
which option is set.

Point Draw
Use Point Draw  to place points from which a line will be made. Point Draw is a good 
way to draw either a curved line, or one with straight sections. 

The minimum number of points is two (which forms a straight line). Three points form an angled line. The 
line is smoothed after placing four or more points. Hold down Shift to place straight sections.
Point Draw is enabled until another tool is selected.

Shortcut
�  Design Panel, Draw: 

Very Smooth Smooth Minimal Smoothing

The line is greatly smoothed, with 
very few points.
This is the default option.

The line is slightly smoothed, 
with fewer points.

The line is represented as a 
series of points, with minimal 
smoothing.
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Using Point Draw
1 Select the desired line color from the Color Select panel. Use Pick Color  if you want to select colors 

from the picture.
To make an enclosed area, also choose a Fill color.

2 Click the Point Draw icon .
3 Click a series of points on the Canvas from the desired start point to the desired end point to draw a 

smoothed line. The points (nodes) are displayed as circles.
4 Right-click on the Canvas to place the line. Each time you click, a point for a new line will be placed 

until you select another feature.

Straight and Curved Lines
Hold down Shift while placing a point to make an angled section. The point will be 
displayed as a square, and that part of the line will be converted to points with no curves.

Draw Straight and Curved Lines
1 Select the desired color in the Color palette.
2 Click the Point Draw icon .
3 Click seven points in a zigzag line, following the squares on the drawing area grid.

The points formed where you clicked are round.
4 Right-click the mouse button to draw the line. A curved line is drawn, using the points that you 

clicked on the drawing area.

5 Hold down the Shift key and click seven more points.
The points are now square.

6 Right-click the mouse button to draw the line. This time the line has straight sections.

Bezier Draw
Use Bezier Draw  to draw shapes with finely graduated curves. Control the exact shape 
of the line using the black handles to either side of the points you place.

The points (nodes) for Bezier lines are always square.
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Click to place Corner points, or click and drag to place curve points 
with handles.

For information on Control Points and the other Bezier Line editing tools, see 
“Convert Points” on page 40.

Creating Bezier Lines
When creating Bezier lines:

• Click without dragging to create a Corner point (no handles)
• Click and drag to create a Curve point (the handles are initially symmetric)

Use the Shift key while drawing to affect how the handles are placed:

• Hold down the Shift key while dragging to place the first handle opposite the position 
where the key was pressed, and the second handle where the mouse button was 
released (the handles are asymmetric and can be angled  ).

• Hold down the Shift key before clicking, then drag and release. A single handle is placed 
where the mouse button was released. 

Editing Bezier Lines
When a point is dragged, its handles move with it, keeping the same angle and distance.

• The handles on a Curve point can be moved independently along the straight line 
between the point and handles.

• Hold down the Shift key while dragging a handle to create an angle at the 
point between the two handles.

• Use Insert Points  and Delete Points  on the Design Panel to add and 
remove points from the Bezier line.

Shortcuts
�  Design Panel, Draw:
�  Keys: Alt, P, BM

Draw a Circle in Bezier Mode
1 Click the View tab, and ensure that Grid size is set to 10mm, and that the canvas is set to 100mm x 

100mm.
2 Click the Draw tab.
3 Ensure that Fill is not selected (No Fill  should be highlighted).
4 Select a color for your line.
5 Click Bezier Draw  to select (highlight) it. The Bezier Draw pointer appears .
6 Click to place a point, then click to place three more of these square points in a rough curve.
7 Right-click to finish the line. The points are joined by straight lines.

These are Corner Points, in Bezier Mode they are joined by straight lines.
8 Click Undo  to remove the line.
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9 Starting 2 squares above the center of the canvas, click and drag to 
the right one square, to the crosshairs of the next grid square.

10 Release the mouse button.
A white square (a Point) appears at the placed where you clicked, and a 
black handle appears at the place where you released the button. This is 
the forward handle.

11 Note that a second handle has appeared the same distance behind 
the white point.
This is the backward handle, it is the same distance from the white point 
as the forward handle (it is symmetrical).

12 Starting 2 squares to the right of the center of the grid, click and drag 
downwards one square, then release the mouse button.
A curved line appears between the two square white points.

13 Starting 2 squares below the center of the grid, click and drag one 
square to the left to place the next section of the curved line.

14 Then, starting 2 squares to the left of the center of the grid, click and 
drag one square upwards to place another section of the curved line. 
You should now have three quarters of a circle.

15 Move the pointer over the square white point on the right. The 
pointer changes to the Move pointer .

16 Drag the point and place it exactly where the grid lines cross.
17 Move the pointer over the forward handle for that point (the black 

handle below the point that you just moved).
18 Drag the handle a about half a square downwards. The backward 

handle for this point moves the same distance upwards.
While you are still placing points, if you adjust the handles they behave symmetrically. You can also drag to 
add symmetrical handles to a Corner point.

19 Move the handle to the right and left.
Note that the curved line changes shape as you move the handle.

20 Move the forward handle so that both handles are over the cross 
hairs of the squares above and below the point, and so that the line 
between the handles runs along the grid line.

21 If needed, adjust the other points and handles so that you have a 
smooth three quarters curve.

22 Move the pointer over first point that you placed until it becomes a 
cross.

23 Click on that original point to form a circle.
Alternatively, right-click and select Finish and Close Line in the 
context menu to place the line. 

Edit a Bezier Line
24 In the Draw section of the Design Panel, click Edit Points . The 

points and their handles are displayed.
25 Move the pointer over the handle above the point on the right (the 

backward handle for the second point in the line).
26 Drag the handle a short distance downwards. This time the handle 

below (the forward handle) does not move, and the shape of the 
circle distorts.
When editing a line the points are Curved, and not Symmetric. The 
handles can be moved independently along the straight line.

27 Drag the handle up to its previous position and the shape becomes a 
circle again.

28 Hold down the Shift key and drag the handle to one side. A corner is 
created in the shape.
Use the Shift key to create a corner or other angle in the line.
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29 In the Points section of the Design Panel, select Convert Points to Curve . The pointer changes to 
the Convert Points to Curve pointer .

30 Click on the point. The handles become symmetrical, and the shape you drew becomes a circle again.
For more information on Control Points and the other editing tools, see “Convert Points” on page 40.

31 In the Points section of the Design Panel, select Convert Points to Corner . 
32 Move the pointer over one of the points in your line. The pointer 

changes to the Convert Points to Corner pointer ..
33 Click on the point. It now has no handles, and the sections of the line 

by it are straight.
There are no handles to drag, so you can only change the line by moving 
this Corner Point. Use Corner Points for straight lines.

34 In the Points section of the Design Panel, select Convert Points to 
Curve .

35 Click on the corner point. It changes back to a curved point.
36 Click Edit Points .
37 Drag the upper handle downwards very close to its point and release 

the mouse button. The handle vanishes, and the section of the line 
without a handle becomes straight.

38 Drag the other handle upwards. It also vanishes.
This is another way of creating a corner point.

39 Select Convert Points to Curve  and use it to change the corner 
point back to a curved point.
You can use Convert Points to Curve to regain use of both handles.

40 Right-click to deselect Convert Points to Curve.
To create a corner point with full control over the angle of the lines, hold 
down Shift and click the point. You can then move the handles 
independently.
To create a flower design from a motif using Bezier lines see “Draw a 
Flower using Bezier Curves” on page 26.

Draw a Flower using Bezier Curves
1 Open PREMIER+ ECQ™ and in the View tab, and ensure that Grid size is set to 10mm, and that the 

canvas is set to 100mm x 100mm.
2 Select Load Background .
3 Load the picture file 'Motif Flower.png’ from the samples area on the website: 

www.premierplusecq.com
4 Drag the Background slider to the left so that the picture is very pale.
5 In the Design Panel, ensure that Fill is not selected (No Fill  should be highlighted).
6 Select a color for your line.
7 Set the Line width to 0.5mm.
8 Click Bezier Draw  to select (highlight) it. The Bezier Draw 

pointer appears .
See “Draw a Circle in Bezier Mode” on page 24 for the essentials 
of drawing Bezier lines.

9 At the left side of the base of the petal at the top, click and 
drag up and slightly to the left, then release the mouse 
button.

10 Starting where the petal to the left meets the petal you are 
drawing, click and drag upwards a short distance to where 
the next set of grid lines cross.

11 Click (without dragging) to place a point at the tip of the 
petal. This is a Corner point.

12 Move the pointer over the second square white point. The 
pointer changes to the Move pointer .
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13 Drag the point a short distance up and to the left, along the 
outline of the petal until the curved line underneath fits the 
outline of the drawing.

14 Click and drag downwards a short distance from the mid 
point of the right side of the petal.

15 Click to place a single point where the line touches the next 
petal.
As you become more skilled, try clicking and dragging to place 
a curved line using a single point at the base of the petal.

16 Right-click to place the line.
The curve of the line will probably need some adjustment, but 
this is better done later, after you have placed lines for the other 
petals.

17 At the left side of the base of the petal to the right of the one 
that you just drew, click and drag upwards a short distance, 
then release the mouse button.

18 Starting where the petal to the left meets the petal you are 
drawing, click and drag diagonally towards the top right 
corner of the grid.

19 Release the mouse button when you reach the grid line 
above.

20 Click (without dragging) to place a point at the tip of the 
petal.

21 From the mid point of the right side of the petal, click and 
drag diagonally towards the bottom left corner of the grid.

22 Click to place a single point where the line touches the next 
petal.

23 Use the Move pointer to adjust the position of the white 
squares so that the curved line fits the picture behind.
You can further adjust the Bezier line using the black handles.

24 Right-click to place the line.
25 Starting at the bottom left of the third petal, click and drag a 

short distance diagonally to the right to place the first point.
26 Where the outline of the petal meets the grid, click and drag 

a horizontal line a short distance to the right to place the 
next part of the curve.

27 Click to place a point at the tip of the petal.
28 Mid way down the other side of the petal, click and drag to 

the left and slightly down to place the next point.
29 At the base of the petal, click to place a final point, then 

right-click to place the line.
30 Place Bezier curve lines to draw the other petals, finishing at 

the petal to the left of where you started.
If you move the black handle to the left or right as you draw, 
you can place the curve to follow the outline, often with no 
need for later editing.

31 Right-click to finish placing the Bezier line.
32 Click outside the design to deselect the final petal.
33 Click the Line color block and choose a golden yellow color.
34 Click the Fill color block and choose a pale yellow color.

The Fill color changes to your selected color from no color.
35 Click Bezier Draw  to select (highlight) it. The Bezier Draw pointer appears .
36 Starting at the top of the center of the flower, click and drag a short distance to the right, then release 

the mouse button.
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37 Click and drag vertical and horizontal lines of similar lengths to place the other three points creating 
the circle.

38 Right-click to place the center of the flower.
39 Click Edit Points . The points you drew for the center of the flower can be seen.

40 In the FilmStrip, click on each petal in turn, and make a note of the ones you will need to adjust.
41 Adjust the handles on the points to make the Bezier line follow the 

background.
If the handles from two different points overlap, move both nearer to 
their own point, to smooth the curve. For more information on editing, 
see “Edit a Bezier Line” on page 25.

42 When you have made your changes on one petal, select the next 
petal in the FilmStrip and adjust that one.
If you find that one of corner points actually has very short handles, 
either use Convert to Corner  in the Draw tab to change it to a corner, 
or drag the handles sufficiently close to their point that they vanish.

43 Save your flower. You can adjust it further when you open the file 
again.
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Snap to Line
When the Snap to Line  option is selected, if the mouse pointer is close to an existing 
line, any points placed will move on top of the old line, and the new line will snap to the 
existing one. 

Snap to Line works with Point Draw  and Bezier Draw , and when using Edit 
Points .

Snap to Line allows you to place points so that they align with other objects cleanly and without a gap.

You can use Snap to Line  when editing. See “Snap to Line” on page 37.

Shortcuts
�  Draw Tab, Snap: 
�  Keys: Alt, D, NL

Snap to Grid
Use Snap to Grid  to align objects to the Grid lines when they are drawn using Point 
Draw , Bezier Draw  and Insert Shape , or when they are moved.

Shortcuts
�  Draw Tab, Snap: 
�  Keys: Alt, D, NG

Closing Lines
You can join lines to themselves when using Freehand Draw , Point Draw  and Bezier 
Draw .

Use Multiply to automatically create copies of lines.

Closed Lines
If a line is drawn close to its own starting point, then the mouse 
pointer will change to a cross . 

If that line is completed while the pointer is a cross, the line will be 
closed to form an area that may be filled.

Trace Line
Use Trace Line  to trace the outline of a background picture to create a line drawing. 
Use the Color Tolerance slider to select the desired part of the picture.

Place points with Snap to Line Lines snapped together
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Use Trace Area to trace a picture with no outlines.

Shortcuts
�  Design Panel, Draw: 

Trace a Picture with Trace Line
1 Use Load Background  in the View tab to load a picture with clear 

outlines, or a line drawing.
Trace Line finds the center of a line or area when tracing. Use Trace Area, 
or Trace Area & Hole to trace a filled area without clear outlining.

2 In the Design Panel, click Trace Line .
3 Hover the pointer over the outline that you wish to trace.

A red and blue highlight on the Canvas shows the outline that will be 
traced. 
To find an outline, it may be best to zoom in and to fade the background 
on the View tab.

4 Drag the Color Tolerance slider below the Trace icons until the 
required part of the picture is selected.

5 Click to trace the outline.
Your traced outline will appear in the FilmStrip.

Trace Area
Use Trace Area  to trace a background picture with no outline to create a filled drawing, 
or a line drawing. Use the Color Tolerance slider to select the desired part of the picture.

Use Trace Line to trace a picture with good outlines to create a line drawing.

Shortcuts
�  Design Panel, Draw: 

Trace a Picture with Trace Area
1 Use Load Background  in the View tab to load a picture 

without clear drawn outlines.
Trace Area finds the outline of an area when tracing. Use Trace Line to 
trace a clear outline, or Trace Area & Hole to trace a filled area with a 
hole.

2 In the Design Panel, click Trace Area . 
3 Hover the pointer over the area that you wish to trace.

A red and blue highlight on the Canvas shows the area that will be 
traced. 
To view the area that you have placed, it may be best to zoom in and 
to fade the background on the View tab.

4 Drag the Color Tolerance slider below the Trace icons until the 
required part of the picture is selected.

5 Click to trace the area in the picture.
Your traced area will appear in the FilmStrip.
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Trace Area & Hole
Use Trace Area & Hole  to trace an area of a background picture that includes a hole to 
create a filled drawing, or a line drawing. Use the Color Tolerance slider to select the 
desired part of the picture.

Shortcuts
�  Design Panel, Draw: 

Trace a Picture with Trace Area & Hole
1 Use Load Background  in the View tab to load a picture 

without clear outlines.
Trace Area & Hole finds the outlines of an area when tracing to trace a 
filled area with a hole.

2 In the Design Panel, click Trace Area & Hole . 
3 Hover the pointer over the outline that you wish to trace.

A red and blue highlight on the Canvas shows the outside of the 
area that will be traced, and any holes in the area are highlighted 
by a green and yellow dashed line. 
To view the area that you have placed, it may be best to zoom in and 
to fade the background on the View tab.

4 Drag the Color Tolerance slider below the Trace icons until the 
required part of the picture is selected.

5 Click to trace the area in the picture.
Your traced area will appear in the FilmStrip.
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Insert Tab
Use the Insert tab to add Shapes, Lettering and Designs to your drawing.

Drawing Shapes
Insert Shape
Use Insert Shape  to add shapes to the drawing. The shape will be drawn as a closed 
line, that may be filled. Select your shape from the drop-down list. 120 different shapes are 
available.

Hold the Shift key down when resizing with Insert Shape  to keep the original proportions of the shape. 
For example, use Shift to draw a square rather than a rectangle, or a circle instead of an ellipse.
If Snap to Grid is used when drawing a shape, the shape will snap to the grid lines.
Use Multiply to automatically create copies of shapes.

Shortcuts
�  Insert tab, Shape: 
�  Keys: Alt, I, S

Draw a Shape
1 Select the desired line and fill colors and the line width.
2 In the Insert Shape drop-down menu, select a shape.
3 Click the Insert Shape icon . The shape is placed on the 

canvas.
4 Drag the corner handles to resize as desired.

To resize proportionally (so that a square remains square), place the 
pointer over the corner handle so it becomes a double-arrow pointer, 
then hold down the Shift key and drag.
Hold down Ctrl to resize from the center. By default, shapes are 
drawn from the corner.

5 Click outside the shape to deselect.
6 If the shape needs to be moved, click to reselect, then move.

Alternatively, use one of the select tools to move the shape.

Shape Type
Select one of 120 shape types from a drop-down list.

Add designs to your drawing

Create Lettering to add to your drawing

Choose a Shape to add to your drawing
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Insert Lettering
Use Insert Lettering  to add text to your picture in any TrueType® or Open Type® font 
available on your computer. Text is drawn using the selected line and fill colors. 

Choose from Regular, Bold, Italic or Bold Italic styles, and adjust the font size in points. 
Then enter the desired text and click Insert Lettering . The text then appears in the 
center of the canvas in a highlighted box that may be moved, resized or rotated. Create 
multi-line monograms by pressing ENTER while typing in the Text box.

Shortcut
�  Insert tab: 
�  Keys: Alt, I, L

Add Lettering to Your Drawing
1 Select the desired colors for line and fill in the Design Panel. 

Use Pick Line Color  or Pick Fill Color  to select colors from the picture.

2 Click the drop-down arrow for the Font and 
select the desired TrueType® Font installed on 
your computer.

3 Click the drop-down arrow for Style and choose 
Regular, Bold, Italic or Bold Italic.

4 Set the size in points by typing in a number, or click on the drop-down arrow and choose a point size.
5 Choose the Alignment for your text.
6 Click in the Text box and the arrow cursor becomes an I-bar. 
7 Type the desired text. Press Enter to create a new line and type more text.
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8 Click the Insert Lettering icon . The lettering is placed on the canvas. The selection box has 
handles to adjust it.

9 If desired, use the resize handles to make the text bigger or smaller. Hold down Shift to resize 
proportionally, and Ctrl to resize from the center. Use the rotate handle to rotate the text to any 
degree.

10 Click anywhere outside the box to deselect.
Use Multiply to automatically create copies of the text.

Design Gallery
Use the Design Gallery  to add any of the clipart pictures included with your PREMIER+ 
ECQ™. An added Gallery design is automatically selected, ready to be moved or copied.

To see the name of a Gallery design, position the arrow pointer over the desired 
thumbnail. A label showing the file name will appear.

Use Multiply to automatically create copies of Gallery designs.

Shortcut

�  Insert tab: 
�  Keys: Alt, I, M

Add a Gallery design to Your Drawing
1 Click the Design Gallery icon  and the Viewer dialog box will be displayed.

2 To look at Gallery designs in a different folder, select a folder in the browse pane on the left.
The browser only looks for Gallery designs folders in ProgramData\VSMSoftware\Premier+ECQ\Gallery

3 Scroll down to see more Gallery designs, if available.
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4 Click a thumbnail picture to select a Gallery design, then click the 
Open button at the bottom of the window. Alternatively, double-
click on a thumbnail picture to load the Gallery design onto the 
screen. The Gallery design is placed in the picture with a selection 
box around it.

5 Click and drag the newly placed Gallery design to the required 
position on your picture. You can also resize the Gallery design, and 
flip it or rotate it. You may need to move the Viewer dialog box out 
of the way to position the Gallery design where you want it (click 
and drag the Viewer dialog box using its title bar).

6 Use the scroll bar on the right to display all the Gallery designs in 
the folder, and click a picture to choose a new Gallery design.

7 Continue adding Gallery designs as required. When you select the 
next Gallery design, the previous design is deselected.
Each Gallery design is inserted as a group, so it can be separately 
selected later.

8 Click Close to finish adding Gallery designs.

Insert File
Click Insert File  to display the Open dialog box to add a drawing from your computer 
to your design. See “Insert” on page 13.

Shortcut

�  Insert tab: 
�  Keys: Alt, I, F
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5Editing Drawings

Editing Tools
The editing tools are found on the Design Panel and the Draw tab. The editing tools are 

Edit Points , Insert Points , Delete Points , Knife , Join  and Make Holes .

Editing Individual Point Lines
In the Draw window of PREMIER+ ECQ™, all drawings are made up of lines or groups of 
lines (objects), and each line is defined by a series of points (nodes). You can select any 
individual line and change it by adjusting, adding or deleting points. You can also cut lines 
and groups of lines with the Knife .

Use the Zoom Bar to zoom in close enough to see the separate points clearly.
Point types vary according to the form of the line.

When a line is first drawn, the end points are round unless Shift was used.

Round Points
Round points indicate a curved line. 

You can change a round point to a square point by holding down 
Shift and clicking the point. To change it back, hold down Shift and 
click the point again.

Square Points
Square points indicate a straight line with angled sections. 

You can change a square point to a round point by holding down Shift 
and clicking the point. To change it back, hold down Shift and click the 
point again.

Edit Points
Use Edit Points  to change the position of the points on the currently selected line. Edit 
Points is enabled until another tool is selected, or you right-click to deselect. 

If you edit the points of a filled object, the fill will adjust to the new shape.

Shortcut
�  Draw tab, Points: 

Editing the Points in a Line
1 Click the Edit Points icon .
2 Click the line that you want to edit. Its points will be displayed.
3 Click and drag a point to change the shape of the line. Lift the 

pen or release the mouse button to place the point in its new 
position.
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The Edit Points tool is active until another feature is selected, or you right-click to deselect.
Moving a round point affects the two sections of line to either side of that point. This ensures line 
smoothness. 

Reshaping a Curved Line
1 Draw a curved line.
2 Click the Edit Points icon .
3 Click the line you just drew. The line is defined by a series of round 

points.
4 Click and drag one of the points in the middle of the line.
5 Move the point around freely. You will see the line flex not only up to 

the adjoining point, but to the next point on either side. (The line 
beyond the second point is unaffected.)

6 Release the mouse button. The line takes on the new shape.
7 Hold down Shift and click the points to either side of the 

point you were moving. They become square.
8 Move the point around again. This time the line to the far 

side of the square points will not flex.

Snap to Line
Snap to Line  is available as an option for Edit Points. When selected, if the mouse 
pointer is close to an existing line, the pointer will change to a diagonal bar .

You can use Snap to Line  when drawing. See “Snap to Line” on page 29.

Using Snap to Line
1 Use Freehand Draw  to draw two separate curved lines.
2 Click the Edit Points icon .
3 Select Snap to Line .
4 Click one of the lines you just drew.
5 Click and drag one of the end points towards the middle of the 

other line. As it nears the line, the pointer changes to a diagonal 
bar .

6 Release the mouse button or lift the pen. The two lines are neatly 
joined.

7 Click one of the round points in the middle of the line. Drag the 
point towards and over the other line. Note how the pointer 
changes as you pass over the other line.

Join
Use Join  to join two open lines together.

You cannot join closed lines (shapes) with Join.
Click Join , and all open line endings are highlighted with a circular handle. Click the 
two handles to be joined, or drag one on top of the other.

The line will take on the color of the second handle clicked.
If you Join the two ends of the same line, a closed area is formed.

Joining Two Lines
1 Draw several lines with different colors.
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2 Click Join .
All open line endings are highlighted with a circular handle.

3 Click the end handle of one of the lines to be joined.
4 Click the end handle of the other line to be joined.

The two lines are joined with a straight section, and the joined line takes on the color of the second 
line selected.
You can also drag one handle on top of the other to join two lines.

5 Right-click to deselect.

Delete Points
Use Delete Points  to remove the currently selected point. 

If a middle point is deleted, the line will be redrawn to follow the path between the points 
that are left. 

If an end point is deleted from an open line, the line will be shortened and the next point 
in the line will become the end point. 

Delete Points is enabled until another tool is selected, or you right-click to deselect.

Draw some lines Click Join  to highlight the line ends.

Click the handle for the first line to join. Click to join the two lines.
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Shortcut
�  Draw tab, Points: 

Delete a Point
1 Click the Delete Points icon .
2 Click the line that you want to edit. The points will be displayed.

3 Click each individual point that you want to delete.

 
4 The line will be reshaped. The Delete Points tool is active until another feature is selected, or you 

right-click to deselect.

Insert Points
Use Insert Points  to add a point to the currently selected line. 

Insert Points is enabled until another tool is selected, or you right-click to deselect.

Shortcut
�  Draw tab, Points: 

Add a Point to a Line
1 Click the Edit Points icon  to make sure that you are in Edit Points mode.
2 Click the line that you want to edit. The points will be displayed.
3 Click the Insert Points icon . The pointer changes to the Insert Points pointer .
4 Click the place on the line where you want to add a point. 

The line will be reshaped accordingly. The Insert Points tool is active until another feature is selected, 
or you right-click to deselect.

Click the line to display the points Click to add a point
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Converting Point and Bezier Lines
Use the Convert Points functions to change Bezier lines and Point lines.

Convert Points
Use the Convert Points functions Convert Points to Curve  and Convert Points to 
Corner  to change between types of points in a line in Bezier Mode.

For information on how to draw and adjust Bezier Lines, see “Bezier Draw” on page 23.

Convert Points to Curve
Use Convert Points to Curve  to change the selected point in a Point line or Bezier line 
to a Curved point (for Bezier, a point with handles that can be adjusted independently). 
Right-click to deselect the function.

Shortcuts
�  Design Panel, Points: 

Change a Bezier Mode Point to a Curve Point
1 In the Points section of the Design Panel, click Edit Points .
2 Click on a line created with Bezier Draw to show the points that make it up.
3 In the Points section of the Design Panel, select Convert Points to Curve . 

Edit Points  is no longer highlighted.
4 Move the pointer over a corner point in your line. The pointer changes to the Convert Points to Curve 

pointer .
5 Click on the point. It now has two handles, and the dashed line between them is straight.
6 Click to adjust any other points that you want to change in your design.
7 Right-click to deselect the function.
8 If desired, click the Convert Points to Curve  again and repeat.

For more information on how to adjust Bezier Lines, see “Edit a Bezier Line” on page 25.

Convert Points to Corner
Use Convert Points to Corner  to change the selected point in a Point or Bezier line to a 
Corner point (a point with no handles for Bezier). Right-click to deselect the function.

Shortcuts
�  Design Panel, Points: 

Change a Bezier Mode Point to a Corner Point
1 In the Points section of the Design Panel, click Edit Points .
2 Click on an line created in Bezier Draw to show the points that make it up.
3 In the Points section of the Design Panel, select Convert Points to Corner . 

Edit Points  is no longer highlighted.
4 Move the pointer over one of the points in your object. The pointer changes to the Convert Points to 

Corner pointer .
5 Click on the point. It now has no handles, and the sections of the line by it are straight.
6 Click to adjust any other points that you want to change in your design.
7 Right-click to deselect the function.
8 If desired, click the Convert Points to Corner  again and repeat.

For more information on how to adjust Bezier Lines, see “Edit a Bezier Line” on page 25.
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Convert to Point Line
Use Convert to Point Line  to change the selected Bezier Line to a Point Line. 

The change takes place immediately.

Shortcut
�  Design Panel, Points: 

Change a Bezier Line to a Point Line
1 Click on an object created in Bezier Draw.
2 In the Edit section of the Design Panel, click Convert to Point Line . 

The line changes to a standard Point Line immediately.

Curved points are added to the line when it is converted. If you change your mind, use Undo rather than 
converting back. 

3 If desired, select another object and click Convert to Point Line again to repeat.

Convert to Bezier Line
Use Convert to Bezier Line  to change the selected Point Line to a Bezier Line. The 
change takes place immediately.

A smoothly drawn line with the minimum of points is more likely to produce a good result.

Shortcut
�  Design Panel, Points: 

Change a Point Line to a Bezier Line
1 Click on an object created in Point Mode.
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2 In the Design Panel, click Convert to Bezier Line . The line changes to a Bezier line immediately.
If you change your mind, use Undo rather than converting back. 

3 If desired, select another object and click Convert to Bezier Line  again to repeat.
The number of points in the Bezier line will depend on the number of points in the original line. Delete 
points and adjust the handles on the remaining points to optimize the Bezier line.

Knife
Use the Knife tool  to cut the currently selected line, shape or group (object) into two 
parts. 

One part is automatically selected.

The Knife is deselected automatically after use.

Any filled shapes will be converted into lines when cut with the Knife. As the cut lines will still have a fill type 
assigned to them, the fill will be displayed again if those lines are joined to make another shape, or a 
different shape.

Shortcut
�  Draw tab, Points: 

Cut a Line with the Knife
1 Draw a sloping line.
2 Click Object Select , then click the line that you just drew to ensure it is selected. The line is now 

surrounded by a box.
3 Click the Knife Tool icon .
4 Click to one side of the line that you drew, then drag to get to the other side of the line. A straight line 

representing the path of the cut is displayed.

Point Line Converted to Bezier Line
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5 Release the mouse button to cut diagonally across the line with the Knife. The line is divided in two, as 
can be seen in the FilmStrip.

6 Right-click to finish using the Knife. One section is selected
The Knife can also be used to cut groups. Load a Gallery design , then cut it with the 
Knife. It will now be displayed as two groups that can be moved separately.

Use the Knife Tool to remove an unwanted section of a drawing, then join the remaining lines to make a 
single line.

Selecting Objects
When one of the editing tools is being used, the currently active line or area is surrounded 
by a box. If that box is selected, the line or area can be moved, resized, mirrored, rotated 
and skewed. The selection tools can also be used to select and manipulate several 
individual objects at once, or several objects forming a Group.

You can select more than one object by holding down Ctrl and clicking the desired objects in the 
FilmStrip.See “FilmStrip” on page 57.You can also select a sequence of objects in the FilmStrip with Shift. 
See “Select Objects in the FilmStrip” on page 58. To change the selection of objects on the Canvas, use Add 

to Selection  and Remove from Selection . See “Add To Selection” on page 47 and “Remove From 
Selection” on page 48. 

Select a Block of Objects
The select functions allow you to select a block of lines or areas. A selected block can be 
resized, rotated, skewed, mirrored, moved, copied, cut and deleted.

When making a selection, only objects that are completely enclosed by the selection line will be included in 
the selection.
When a block has been selected, it has a 
selection box around it on the Canvas. 
The selection box has handles which are 
used to resize, rotate and mirror the 
block.
• Click and drag inside the block to 

move it, or use the arrow keys on the 
keyboard to nudge the block by small 
amounts.

• Click and drag the square corner 
handles  to resize the block. 

Select the line Draw the cut line Right-click to end cutting

Mirror Vertical Handle

Rotate
Handle

Resize
Handle

Skew
Handle

Mirror
Horizontal

Handle

Center of
Rotation
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Hold down Shift as you click and drag to resize proportionally. Hold down Ctrl to resize 
from the center.

• Click and drag the round rotate handle  to rotate the block freely. 

• Click the triangular handles  to mirror the block horizontally or vertically.

• Click and drag the center of rotation  to rotate around a different point. 

• Click and drag on of the skew handles  to skew the block. 
• Right-click the block to change the properties of the lines and fills within it. The 

Changing the Colors for Lines and Fills dialog will appear.

See “Changing the Colors for Lines and Fills” on page 21.
If the block is smaller than 1.5mm high or wide, the selection box will just be a plain rectangle with no 
handles.

Inserting or Pasting a Block
When a new selection is added to a design by paste or one of the insert functions, it is 
automatically selected as the current block and Object Select  (or Box Select ) is 
activated. 

Deselecting a Block
Click the drawing area outside a block to deselect it. The selection box around the block 
will disappear. Right-click to deselect a block and also turn off the current select function.

Object Select
With Object Select , click on the object (line or filled area) that you want to select. The 
selection box will show you the extent of the block. Click outside the block to deselect it. 

Object Select is also activated automatically when a block is pasted.

Object Select is enabled until another tool is activated.

Use Add to Selection  with any select function to increase the area of selected objects, or use Remove 

From Selection  to make the currently selected area smaller.

Object Select Click to select an object.

Box Select Click and drag to draw a rectangle around the area you want to select. 

Freehand Select Click and drag to draw an irregular outline around the desired area.

Point Line Select Click a series of points to create an irregular outline of straight or 
curved lines around the desired area.

Select All Select all visible objects in the drawing with one click.

Select None  Deselect all of the objects in the drawing.

Replace Selection Replace the currently selected area with the new selection.

Add to Selection  Add the new selection to the currently selected area.

Remove from Selection Remove the new selection from the currently selected area.
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If the wrong area is selected, click in the active window, but outside the box, to deselect.

Shortcuts
�  Draw Tab, Select: 
�  Keys: Alt, D, O

Select an Object with Object Select
1 Click the Object Select icon .
2 Click on the required object. It becomes the current selection, indicated by a rectangle with white 

handles.
3 If you want to make a new selection, click on a different object to select it.
4 Object Select is enabled until another tool is activated.

Box Select
With Box Select , click and drag to draw a rectangle around the area you want to select. 
Alternatively, click on a line or group to select it. The four-headed arrow Move pointer  
appears as you approach an object. Click and drag around the area you want to select. 
When you release the mouse button, the selection box will show you the extent of the 
block. Click outside the block to make a new selection using this method. Only objects 
that are completely enclosed by the selection line will be selected.

Box Select is enabled until another tool is activated.

Use Add to Selection  with any select function to increase the area of selected objects, or use Remove 

From Selection  to make the currently selected area smaller.

If the wrong area is selected, click in the active window, but outside the box, to deselect.

Shortcuts
�  Draw Tab, Select: 
�  Keys: Alt, D, B

Select Objects with Box Select
1 Click the Box Select icon .
2 Click and drag to draw a rectangle around the required objects.
3 Lift the pen or release the mouse button when the required objects are enclosed. They will become 

the current selection, indicated by a rectangle with white handles.
4 If you want to make a new selection, click outside the current selection to deselect it. Then draw a 

new box around the required objects.
5 Box Select is enabled until another tool is activated.

Freehand Select
With Freehand Select , click and drag to draw an irregular outline around the desired 
area. Alternatively, click on a line or group to select it. The four-headed arrow Move 
pointer  appears as you approach an object. Click Freehand Select and the pointer 
changes to the freehand select pointer . Click and drag to draw an irregular outline 
around the desired area. When you release the mouse the area is closed automatically 
with a straight line between the last mouse position and the start position. The selection 
box will show you the extent of the block. Click outside the block to make a new selection 
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using this method. Only objects that are completely enclosed by the selection line will be 
selected.

Freehand Select is enabled until another tool is activated. Right-click to deselect.

Use Add to Selection  with any select function to increase the area of selected objects, or use Remove 

From Selection  to make the currently selected area smaller.

Freehand Select is useful when an area cannot be easily selected by using the simpler Box 
Select function. 

If the wrong area is selected, click in the active window, but outside the box, to deselect.

Shortcuts
�  Draw Tab, Select: 
�  Keys: Alt, D, F

Select Objects with Freehand Select
1 Click the Freehand Select icon .
2 Click and drag to draw a line around the required objects. The objects inside the line will become the 

current selection, indicated by a rectangle with white handles.
3 The line is closed automatically in a straight line between your start point and end point. If you are 

not close enough to your start point then you could leave out some desired objects by accident.
4 If you want to make a new selection, click outside the current selection to deselect it. Then draw a 

new line around the required objects.
5 Freehand Select is enabled until another tool is activated, or you right-click to deselect.

Point Line Select
With Point Line Select , click a series of points to create an irregular outline of straight 
or curved lines around the desired area. Click Point Line Select and the pointer changes to 
the Point Select pointer . Click a series of points to create an irregular outline of straight 
or curved lines around the desired area, using Shift+click to place a square (straight line) 
point. Click and drag  to reposition an existing point. Click Delete to remove the last–
placed point. Right-click when the area is complete. The selection box will show you the 
extent of the block. Point Line Select may be easier to use than Freehand Select for precise 
selections. Click to deselect. Only objects that are completely enclosed by the selection 
line will be selected.

Point Line Select is enabled until another tool is activated. Right-click to deselect.

Use Add to Selection  with any select function to increase the area of selected objects, or use Remove 

From Selection  to make the currently selected area smaller.

If the wrong area is selected, click in the active window, but outside the box, to deselect.

Shortcuts
�  Draw Tab, Select: 
�  Keys: Alt, D, PS

Select Objects with Point Line Select
1 Click Point Line Select . The pointer changes to the Point select pointer .
2 Click to place the first point for the selection. A yellow square point appears.
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3 Click to place a series of points around the desired area.
As you click the third point on the line, the line becomes closed (it becomes a loop). As you place more 
points the line adjusts itself.
The line may ’swing’ while you place points. Just carry on, you can adjust it afterwards.

4 Use Shift+click to place square points for straight lines.
5 Move the pointer over one of the points on the line. The pointer changes to the Move Point 

pointer . Adjust the point as desired.
When the Move Point pointer is active you can adjust existing points.

If you click while the Freehand Point pointer  is active, another point will be added to the line.
6 When your line is as desired, right-click to surround the area with a selection box.
7 Right-click to deselect Point Line Select.

Select All
Select All  is a one click function that selects all visible objects in the drawing. This is 
useful to resize or reshape the entire drawing.

Shortcuts
�  Draw Tab, Select: 
�  Keys: Ctrl + A; Alt, D, SA

Select None
Use Select None  to deselect all of the objects in the drawing.

Shortcuts
�  Draw Tab, Select: 
�  Keys: Alt, D, SN

Replace Selection
Use Replace Selection  to replace the currently selected area with the new selection.

Replace a Selection
1 Place several objects on the Canvas.
2 Use Box Select  (or another selection tool) to select some of these objects.
3 Ensure that Replace Selection  is selected.

Replace Selection is initially selected.
4 Using Box Select , select some different objects.

The new selection replaces your old selection.

Shortcuts
�  Draw Tab, Select: 
�  Keys: Alt, D, RS

Add To Selection
Use Add to Selection  to add the new selection to the currently selected area.

Add Objects to a Selection
1 Place several objects on the Canvas.
2 Use Box Select  (or another selection tool) to select some of these objects.
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3 Click Add to Selection .
4 Using Box Select , select some different objects.

The new selection is added to your old selection.

Shortcuts
�  Draw Tab, Select: 
�  Keys: Alt, D, AT

Remove From Selection
Use Remove from Selection  to remove the new selection from the currently selected 
area.

Remove Objects from a Selection
1 Place several objects on the Canvas.
2 Use Box Select  (or another selection tool) to select some of these objects.
3 Click Remove From Selection .
4 Using Box Select , select some of the objects within your selection.

The new selection is removed from your original selection.

Shortcuts
�  Draw Tab, Select: 
�  Keys: Alt, D, RF

Modify a Block of Objects
Move a Block of Objects
Move a selected block using click and drag, or nudge. Click on an object inside the block 
and drag it to the required position, or use the arrow keys to nudge it into place.

If Snap to Grid is enabled, the block of objects will snap to the grid when moved.

If you accidentally move the center of rotation , simply click and drag it inside the selection box again.

How to Move a Block of Objects
1 Click on any of the objects inside the selection. The pointer becomes a four-headed arrow . Drag 

the selection to the required position. The rectangle around the selection will be dragged with the 
pointer.

2 Lift the pen or release the mouse button to drop the selection in place. The selected objects will be 
redrawn in their new location.
Alternatively, use the arrow keys to nudge the selection into position, then click outside the block to place 
it.
When you move a selection, you may sometimes move the center of rotation by accident. Simply 
release the center of rotation, then click and drag the selection as usual. The center of rotation will 
snap back to the center of the selection when you drop the selection in its new position.

Resize a Block of Objects
Click and drag one of the square corner handles  to resize the block. The pointer 
becomes a double-headed arrow .

Hold down Shift as you click and drag to resize proportionally. Hold down Ctrl to resize from the center.
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How to Resize a Block of Objects
1 If you want to keep the selected objects in proportion, hold down the Shift key.
2 Click and drag any of the square  resize handles. The pointer becomes a double-headed arrow .
3 Lift the pen or release the mouse button, and then release the Shift key if you used that to keep the 

proportions. The selection will be redrawn at its new size.

Skew a Block of Objects
Skew a block of objects vertically or horizontally using the Skew handles  to the right of 
and below the Center of Rotation. Click and drag either handle to reshape the selection 
box, and the drawing.

How to Skew a Block of Objects
1 Mouse over the horizontal diamond shaped  skew handle. The 

pointer becomes a vertical double-headed arrow .
When the vertical skew handle is used, the pointer becomes a horizontal 
arrow .

2 Drag to skew the drawing.
3 Adjust the skew, then release the mouse button.

When you release the mouse button the selection box is redrawn as a 
square in the new position.

4 Click and drag again to make any further adjustments.
If you mirror a skewed object, this applies to the original shape before the 
skew was applied. To apply it after the skew, deselect and reselect the 
object.
Otherwise, if the skewed object was originally symmetrical only the mirror 
handle may appear to move.
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Mirror a Block of Objects
Mirror a block of objects vertically or horizontally using the triangular mirror handles  
on the block selection box. The pointer becomes a double-headed arrow .

If the object to be mirrored was originally symmetrical, and has been rotated or skewed, deselect and 
reselect before mirroring. This is because the mirroring effect is applied to a design before rotating or 
skewing.

Horizontally Mirror Block
Click the Mirror Horizontal handle  to mirror a block horizontally. 

Vertically Mirror Block
Click the Mirror Vertical handle  to mirror a block vertically.

Rotate a Block of Objects
Click and drag the rotation handle  to rotate the block freely to any angle. The pointer 
becomes the rotate pointer . If desired, move the center of rotation  before rotating 
the block.

The selection box around the block is rotated around the center of rotation.

Move the Center of Rotation
The center of rotation  is initially shown in the middle of the block. Click on or within 
the center of rotation, then drag it to any position in the drawing. This changes the pivot 
point around which the block rotates.
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If you mirror a rotated object, this applies to the original shape before the rotate was applied. To apply it 
after the rotate, deselect and reselect the object.
Otherwise, if the rotated object was originally symmetrical only the mirror handle may appear to move.

Change Color and Other Properties
Once objects have been selected, the line and fill color and other properties of the 
selected block can be changed. 

Select a block to change its properties in the Design Panel.

Change the Color of a Block
1 Select a block of objects of varying colors.

2 In the Design Panel, click on the upper color by the drawing tools, then select a 
new color in the palette. 
To select a new fill color, click on the lower color, then select a new color in the palette.

3 Click OK to apply the new color to your selected block.

Rotate 45º 
Use Rotate 45º  to rotate all selected objects in a block around the Center of 
Rotation .

Shortcuts
�  Design Panel, Edit: 

Transform
Use Transform  to open the Transform dialog, where you can show and change the size, 
rotation and skew of the currently selected block.

Shortcuts
�  Design Panel, Edit: 
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Transform Dialog
Use the Transform dialog box to show and change the size, 
rotation and skew of the currently selected block.

Modify the currently selected block as desired, then click OK 
to show your changes on the Canvas.

Click Undo  to reverse your changes.

Size
Show and change the height  and width , or height  
and width  percentage of the currently selected block.

Proportional
Use this option to keep the relative Height and Width in 
proportion when either is changed.

Rotate
Enter an angle , from 0 to 359 degrees, in the Angle box. The preview shows the 
selected angle.

If desired, move the center of rotation before rotating.

Resize a Flower Drawing
1 Click the Design Gallery icon  and the Viewer dialog box will be 

displayed.
2 Browse to the folder Flowers and Leaves, and click to highlight the 

design Orange Flower.
3 Click Open to load the flower design.
4 In the Draw tab, ensure that Object Select  is active.
5 Click the flower to select it.
6 Click Transform . The Transform dialog box appears.
7 In the Size section, ensure Proportional is checked, then change
8 Height percentage to 75%.

The Width percentage will decrease by the same amount, and in the 
background the flower changes in size.

9 In Rotate, click and hold on the up arrow. The flower rotates.
10 Change the width and height percentage Skew to reshape the flower 

design.
11 Click Close. The flower now uses your new settings.
12 Left-click outside the select box to deselect the flower drawing.

Delete
Use Delete  to delete a block of objects after it has been selected using one of the block 
selection methods (Box Select, Freehand Select, Point Line Select or Select All). 
Alternatively, use the Delete key.

This function differs from Cut because it does not place the objects on the Clipboard Block. Therefore 
objects that have been Deleted cannot be pasted into another drawing (although Undo can be used if the 
wrong objects are deleted).
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Deleting Single Points
Use Delete Points  to delete individual points.

See “Delete Points” on page 38.

Shortcuts
�  Draw Tab, Clipboard: 
�  Keys: Delete; Alt, D, DE

Alignment Tools
The Alignment tools allow objects to be aligned precisely. 

The Alignment tools are only available when more than one object is selected.
Select the objects that you want to align, then use one of the alignment tools. 

Objects can be aligned horizontally or vertically. They can also be centered.

Horizontal Alignment
Align objects horizontally with the Horizontal Alignment  tools.

Align Left
Align Left  aligns all selected objects with the left edge of the object furthest to the left.

Shortcut
�  Keys: Alt, D, AL, H, L

Align Center
 Align Center  centers all selected objects horizontally relative to each other. 

Shortcut
�  Keys: Alt, D, AL, H, C

Align Right
Align Right  aligns all selected objects with the right edge of the object furthest to the 
right. 

Shortcut
�  Keys: Alt, D, AL, H, R

Distribute Horizontally
Distribute Horizontally  aligns all selected objects to be equally spaced horizontally.

Shortcut
�  Keys: Alt, D, AL, H, D

Vertical Alignment
Align objects vertically with the Vertical Alignment  tools.
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Align Top
Align Top  aligns all selected objects with the top edge of the highest object. 

Shortcut
�  Keys: Alt, D, AL, V, T

Align Middle
Align Middle  centers all selected objects vertically relative to each other. 

Shortcut
�  Keys: Alt, D, AL, V, M

Align Bottom
Align Bottom  aligns all selected objects with the bottom edge of the lowest object. 

Shortcut
�  Keys: Alt, D, AL, V, B

Distribute Vertically
Distribute Vertically  aligns all selected objects to be equally spaced vertically.

Shortcut
�  Keys: Alt, D, AL, V, D

Center in Canvas
Use Center in Canvas  to move the selected objects to the center of the Canvas.

Shortcut
�  Status Bar: 

Grouping Selected Objects
In the Draw tab you can edit lines or areas individually, in a selected block, or in groups 
which can remain as a section after saving. You can also place groups in larger groups.

When a drawing is loaded using Insert, all sections will be grouped together, ready for moving, resizing 
and so on.

Group
Use Group  to make a group of all the currently selected objects. Either Group the 
objects permanently, or Group them temporarily while moving or editing them.

A group can be modified in the same way as a block. You can move, resize, skew, mirror and rotate it, and 
change the color of its objects.
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Gallery designs  are made from groups. You 
can use the FilmStrip to see the objects inside 
complex group structures such as the Gallery 
design Hearts.ecq in the Objects section of the 
Design Gallery.

Group can only be used in conjunction with one 
of the selection tools.

Shortcuts
�  Draw Tab, Group: 
�  Keys: Alt, D, G

Group Several Objects
1 Use Freehand Draw  to draw several short lines in the drawing 

area.
2 Look at the Group area in the ribbon bar. The tools are currently 

grayed out (unavailable).
3 Use Box Select  to click and drag to draw a rectangle around the 

lines to select them. The Group tools are now active.

4 While the lines are selected as a block, click Group . The block 
will be changed into a group.

5 Move, rotate and resize the group as a single unit.
6 Click outside the group to deselect it. The Box Select tool is now 

active again, and Group is grayed out.
In the same way that an object partially outside the selection does not 
become part of a block, only objects fully inside the selection can 
become part of a group.

Highlighting a Group or Line
You can select existing objects on the Canvas when a selection tool is active.

1 Place a mixture of lines and groups in the 
drawing area.

2 Right-click on the Canvas to deselect the 
drawing tool.

3 Click outside the drawing area to deselect 
everything.

4 Click to select a line. If it is part of a group the 
whole group will be displayed as a block. If it is 
not, the line will form a block on its own.

5 Move the mouse pointer over the drawing 
area. As it goes over a selected line the pointer 
changes from an arrow  to a four-headed 
arrow .

6 To select all objects at once, click Select 
All .
Highlight each group, or individual line, in turn using the Tab key. Alternatively, view the complete 
structure of your drawing in the FilmStrip.
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Ungroup
Use Ungroup  to split the currently selected group into the objects which make it up. 
These may be lines, filled or unfilled areas, or smaller groups.

Ungroup can only be used when a group is selected.

Shortcuts
�  Draw Tab, Group: 
�  Keys: Alt, D, UG

Ungroup Grouped Objects
1 Open the Insert tab.
2 Select the Design Gallery  and 

load a design into the Canvas. 
Click Close.
The design is displayed as a 
group in the drawing area. 

3 Click the Draw tab.
Note that the Group tools in the 
ribbon bar are active.

4 Move the design around the 
screen. It moves as one unit.

5 In the Group section of the Draw 
tab, click Ungroup . The 
group has now become a block.
In the FilmStrip note that there are 
now several objects within the 
block.

6 Move the Gallery design. As it is a block it moves in one piece.
While the block is still selected you can reverse the effects of Ungroup by using either Group or Undo.

7 Click outside the design. A box is no longer displayed around the design.
8 Click inside the design again. This time only a part of the design is selected. You can move it 

separately.

Use Ungroup followed by Delete, then Group again to remove an unwanted section from a drawing.
If a piece of a drawing is accidentally left behind when you move it, use Undo and Group before trying 
again.

A Gallery design is a single Group When Ungrouped it is a block. You can move 
a part separately
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Ungroup All
Use Ungroup All  to split all the groups within the selected group into their individual 
lines and areas.

You can use Undo  to reverse the effects of Ungroup All.

Use Select All  and then Ungroup All to Ungroup whole drawings.

Shortcuts
�  Draw Tab, Group: 
�  Keys: Alt, D, GA

FilmStrip
Use the FilmStrip to view the structure of objects in your drawing. View your drawing 
structure by opening its groups. Examine and move the individual lines or fills (paths) and 
groups within those groups.

FilmStrip Items
The top, or Root, entry in the FilmStrip shows the whole drawing in miniature. It represents 
the Group (object) that contains all the other objects in the drawing.

Below the top entry, the FilmStrip shows the sequence 
of objects within the drawing. The currently selected 
object is highlighted in the FilmStrip, and objects can 
be selected directly in the FilmStrip. 

Each item in the FilmStrip shows two pieces of 
information: the object and its type.

Object
Each object is represented graphically, showing its 
shape and color. Double-click a group to see the 
objects within it.

Object Type and Name
The name of the object type may be shown. The types 
are Group and Path (for Cardinal Path, or line). Paths 
may be open or closed. Closed paths may be filled or 
unfilled.

Scroll Bar
Use the scroll bar to move rapidly up and down the 
FilmStrip.

Group Object Layout
Order

Scroll
Bar
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Select Objects in the FilmStrip
To select an object, click it in the FilmStrip. If necessary, use the scroll bar on the side of the 
FilmStrip to view the object, or double-click to open the Group it is in. When you edit or 
select a line in the drawing area it is also highlighted in the FilmStrip.

If you have zoomed in, the selected object may not be shown on the visible part of the drawing area. To see 

the object, either Zoom To Canvas  or use the scroll bars on the edges of the drawing area.

You can also select objects using the keyboard. Click on the FilmStrip, then use the arrow 
keys to step up and down the list by one object at a time. Use the Page Up and Page Down 
keys to jump up and down the list one screenful at a time. Use Home to go to the first 
object and End to go to the last object.

Open a Group by double-clicking it, or by clicking on the plus sign  to its left.

To select several objects that are next to each other, hold down the Shift key, and click the 
start and end object in the sequence. 

To select objects that are not next to each other, hold down the Ctrl key and click the 
desired objects.

When selecting a mixture of paths and groups with Ctrl + click, if you want to change their properties, 
select the paths within the groups, not the group headings.

Change the Sequence of Objects
Objects and groups of objects may be moved up and down the FilmStrip with the arrow 
(Layout Order) buttons.

Objects can only be moved within their current group within the FilmStrip. To move an 
object outside its group, Cut and Paste it. Alternatively, use Ungroup, move the object, and 
Group the remaining objects again.

You can move any object in the FilmStrip except the Root (first) entry. 
To delete an object, select it in the FilmStrip and click Delete .

Layout Order
The Layout Order buttons are used to move objects within the FilmStrip.

Move Forwards
Move Forwards  brings the object one step down the FilmStrip.

Move Backwards
Move Backwards  brings the object one step up the FilmStrip.

Move to Front
Move to Front  places the object at the bottom of the FilmStrip or Group.

Move to Back
Move to Back  places the object at the top of the FilmStrip or Group.
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Make Holes
Use Make Holes  to create a hole in the fill for a shape. This is done by combining the 
paths (lines) for the selected objects. Make Holes is only enabled when more than one 
filled shape is selected.

The shapes should overlap for Make Holes to show an effect.

Shortcuts
�  Draw Tab, Combine: 
�  Keys: Alt, D, MH

Use Make Holes to Create a Filled Shape with a Hole
1 Use Freehand Draw  or Insert Shape  to draw a filled shape.

Make Holes is grayed out (unavailable) while you do this.
2 Use Freehand Draw or Insert Shape to draw a second filled shape completely inside the first filled 

shape (for example, a circle within a circle).
3 Use Box Select  to select both shapes as a block. Make Holes  is now available.

Check in the FilmStrip to see that both shapes are selected.
4 Click Make Holes . The shape within a shape is now a filled area with an unfilled hole in it.

All of the combined lines and fills are now the same colors.

Uncombine
Use Uncombine  to break apart an object combined with Make Holes.

Shortcuts
�  Draw Tab, Combine: 
�  Keys: Alt, D, P, U

Uncombine a Combined Object 
1 Use Box Select  or another selection tool to select an object that you combined with Make 

Holes .
2 In the Combine area of the Draw tab, click Uncombine . The combined object is split into separate 

paths, and any holes in fill areas have now gone.
The lines and fills remain the same colors that they were when combined.

Draw a filled shape Add a filled shape inside Select Make Holes
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Cut, Copy and Paste
Once objects have been selected with the selection tools, they can be cut and copied onto 
the clipboard. 

In the Draw window, only objects that are completely enclosed by the selection line will be selected.

Cut
Use Cut  to cut the selected part of the drawing to the clipboard, where it can be pasted 
into the same file or a new drawing.

Cutting to the clipboard replaces the contents previously stored there.

Shortcuts
�  Draw Tab, Clipboard: 
�  Keys: Ctrl + X; Alt, D, CU

Copy
Use Copy  to make a copy of the selected part or all of the drawing and place it on the 
clipboard, where it can be pasted into the same file or a new drawing.

Copying to the clipboard replaces the contents previously stored there.

Shortcuts
�  Draw Tab, Clipboard: 
�  Keys: Ctrl + C; Alt, D, CC

Paste
Use Paste  to place part or all of a drawing that has been cut or copied to the clipboard 
onto the screen. The pasted area appears in a highlighted box, ready to be moved or 
altered.

Shortcuts
�  Draw Tab, Clipboard: 
�  Keys: Ctrl + V; Alt, D, CP

Duplicate
Use Duplicate  to make a copy of the selected part or all of the drawing, which is 
automatically pasted on the Canvas below and to the right of the original. 

Shortcuts
�  Draw Tab, Clipboard: 

�  Keys: Alt, D, CD
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Undo and Redo
Undo
Use Undo  to reverse the last action that has been applied to the picture on the screen, 
such as moving, deleting or mirroring an area, drawing a line, box or ellipse, or an effect 
that has been applied. Unlimited Undos are possible in the Draw window.

Only actions that change the picture can be reversed using Undo on the Draw window. For example, the 
Zoom commands cannot be reversed using Undo.
The Undo and Redo steps are reset when a new picture is opened.

Shortcuts
�  Quick Access Toolbar: 
�  Keys: Ctrl + Z; Alt, 7

Redo
Use Redo  to reverse any actions that have been undone. Redo only works if nothing 
has happened after the last Undo. For instance, if you draw a line, then Undo and draw a 
rectangle then it is not possible to Redo the line because something different has 
happened instead. Unlimited Redos are possible in the Draw window.

The Undo and Redo steps are reset when a new picture is opened.

Shortcuts
�  Quick Access Toolbar: 
�  Keys: Ctrl + Y; Alt, 8
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6Multiply
Use Multiply  to repeat drawings or actions automatically by reflecting across and/or 
down, and by rotating. Symmetrical designs can be created quickly and easily. All changes 
in the drawing, such as adding, editing, pasting and removing lines and groups are 
multiplied.

You can use the select tools, and  Group and Ungroup, while Multiply is active.
Multiply can reflect or rotate images. Existing objects will not be affected, but the selected 
objects or any new object that is either drawn or pasted in will be reflected or rotated. The 
blue Multiply reflection lines are shown on the canvas when Multiply is enabled.

Try drawing and inserting designs while Multiply is active.
Click Enable Multiply  on the Multiply tab to turn Multiply on, and click Apply 
Multiply  to place the multiplied designs on the canvas.

Multiply Mode
Use the Multiply Mode functions to set your Multiply style, and to enable Multiply.

Enable Multiply
Use Enable Multiply  to activate the Multiply options.

Only new objects, or objects that were selected when Multiply was started, are affected by Multiply.

Shortcuts
�  Multiply Tab, Multiply Mode: 
�  Keys: Alt, M, E

Apply Multiply
Use Apply Multiply  to place the multiplied designs on the canvas.

Shortcuts
�  Multiply Tab, Multiply Mode: 
�  Keys: Alt, M, A

Cancel Multiply
Use Cancel Multiply  to cancel the current Multiply.

Place multiplied objects on canvas Set options for Horizontal and Tile

Set options for Multiply in Circle

Choose a Multiply mode

Set options for Vertical and TileMultiply the selected objects

Cancel
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Shortcuts
�  Multiply Tab, Multiply Mode: 
�  Keys: Alt, M, N

Circle
Use Circle  to multiply designs in a circle, and to create kaleidoscope style patterns. Use 
the Circle Options to change the number of designs, and to mirror the designs.

Shortcuts
�  Multiply Tab, Multiply Mode: 
�  Keys: Alt, M, MC

Horizontal
Use Horizontal  to multiply designs along a horizontal line. Use the Horizontal Options 
to change the number of designs, the size of the Multiply zone, and to mirror the designs.

Shortcuts
�  Multiply Tab, Multiply Mode: 
�  Keys: Alt, M, MR

Vertical
Use Vertical  to multiply designs along a vertical line. Use the Vertical Options to change 
the number of designs, the size of the Multiply zone, and to mirror the designs.

Shortcuts
�  Multiply Tab, Multiply Mode: 
�  Keys: Alt, M, MV

Tile
Use Tile  to multiply designs within a horizontal and vertical 
grid, from a square blue Multiply zone. 

Use the Horizontal Options and the Vertical Options to change 
the number of designs, the size of the Multiply zone, and to 
mirror the designs.

Shortcuts
�  Multiply Tab, Multiply Mode: 
�  Keys: Alt, M, MT

Use Multiply to Create Copies of a Design
1 Load or draw a design.
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2 Select the design with Box Select , Point Line Select , or 
Freehand Select .

3 Drag the design upwards and to the left to move it a short distance 
from the center of the canvas.

4 Click the Multiply tab.
5 Click Enable Multiply . Your design is multiplied in a circle with four 

repeats. The reflected areas are marked by heavy horizontal and vertical 
blue lines.
The initial settings are Circle  and four Repeats, without Mirroring.

6 In the Multiply tab, click Horizontal . The three repeated designs are 
now either side of the original, and the blue Multiply lines run vertically.

7 In the Multiply tab, click Vertical .
The three repeated designs lie above and below the original, and the Multiply lines run 
horizontally.

8 In the Multiply tab, click Tile .
There are now 15 copies of your original design, forming a grid, with the original design 
within a blue outlined square.

9 If needed, move your original design within the blue square.
This blue square forms the original area that is multiplied.
You can use the Mirror and Size options to reflect the multiplied designs, and to set the 
size of the zone within the blue lines.

10 Click Apply Multiply  to place the multiplied designs on the canvas.

To go back to your original single design, click Undo  after using Apply Multiply.

Circle Options
The Circle Options enable you to set the number of repeats and reflect copies of the 
multiplied designs as facing pairs.

Repeats
Set the number of repeats for the multiplied circle of designs from 2 to 40. The initial 
number is 4.

Shortcuts
�  Keys: Alt, M, CR
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Mirror
Use Mirror  to reflect the designs to form pairs. Each alternate copy of the design is 
reflected. This generally looks best if the number of Repeats is an even number.

Shortcuts
�  Keys: Alt, M, CM

Alternative Mirror
Use Alternative Mirror  to reflect the designs with a rotated axis.

Shortcuts
�  Keys: Alt, M, CA

Use the Multiply Circle Options
1 Use New Window to start a new work area.
2 Load or draw a design.
3 Select the design with Box Select , Point Line Select , or 

Freehand Select .
4 Drag the design upwards and to the left to move it a short distance 

from the center of the canvas.
5 Click the Multiply tab.
6 Click Enable Multiply . Your design is multiplied in a circle with four 

repeats. The reflected areas are marked by heavy horizontal and vertical 
blue lines.
The initial settings are Circle  and four Repeats, without Mirroring.

7 In the Circle Options area, increase Repeats to 6.
There are now six blue Multiply lines.

8 Move your design so that it does not cross any of the blue Multiply lines.

Without Mirror With Mirror With Alternative Mirror
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9 In the Circle Options area, click Mirror .
Pairs of designs now face each other.

10 In the Circle Options area, click Alternative 
Mirror .
Some of your designs may now be badly overlapping.

11 Move your original design so that it is between two 
of the blue Multiply lines, and over the central grid 
line.
When using Mirror and Alternative Mirror, designs will 
overlap if they cross one of the blue Multiply lines.

12 Try using a different number of Repeats, and options 
with and without Mirroring.

13 Click Apply Multiply  to place the multiplied 
designs on the canvas.

Horizontal Options
The Horizontal Options enable you to set the number of repeats, set the Size of the 
Multiply zone, and reflect copies of the multiplied designs as facing pairs.

The initial settings use 4 Repeats and a Size of 25.0 mm in a 100 mm x 100 mm Canvas.

The Horizontal Options are used with the Horizontal and Tile Multiply Modes.

Repeats
Set the number of repeats for the horizontal line of designs from 2 to 40. The initial 
number is 4.

Shortcuts
�  Keys: Alt, M, RR

Size
Use Size to set the width of the Multiply zone from 10.0.mm to 1000.0 mm. in steps of 0.1 
mm. The initial Size is 25.0 mm.

Increase the Size to move the designs further apart. Decrease the Size to move the designs 
closer together, and to overlap the designs.

It is often desirable to adjust the Size until designs are touching or very close together when creating an 
embroidery, as this will reduce the number of movement stitches.

Shortcuts
�  Keys: Alt, M, RS

Mirror
Use Mirror  to reflect the designs to form pairs. Each alternate copy of the design is 
reflected.

Shortcuts
�  Keys: Alt, M, RM
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Use the Multiply Horizontal Options
1 In the View tab, ensure that the Canvas is set to 100mm x 100mm in size.
2 Load or draw a design.
3 Select the design with Box Select , Point Line Select , or Freehand Select .
4 Drag the design upwards and to the left to move it a short distance from the center of the canvas.
5 Click the Multiply tab.
6 In the Multiply tab, click Horizontal . 
7 Click Enable Multiply . Three repeated designs can be seen either side of the original. Blue Multiply 

lines run vertically.

The initial settings are 4 Repeats, with the Size of the Multiply zone set to 25.0mm.
8 Set Repeats to 5. At least one of your designs is outside the Canvas grid, and the central blue line may 

cross your design.

Pale blue lines mark out the other Multiply zones.
9 Set the Size to 20mm, so that the designs will fit within the Canvas grid.

Use Size to fit a design within a Multiply zone.
10 Ensure that your original design is between the two central heavy blue lines, then click Mirror .

The designs form facing pairs.

11 Move the central design to the right towards its reflected copy. The designs now overlap.

Vertical Options
The Vertical Options enable you to set the number of repeats, set the Size of the Multiply 
zone, and reflect copies of the multiplied designs as facing pairs.

The initial settings use 4 Repeats and a Size of 25.0 mm in a 100 mm x 100 mm Canvas.

The Vertical Options are used with the Vertical and Tile Multiply Modes.

Repeats
Set the number of repeats for the horizontal line of designs from 2 to 40. The initial 
number is 4.

Shortcuts
�  Keys: Alt, M, VR

Size
Use Size to set the width of the Multiply zone from 10.0.mm to 1000.0 mm. in steps of 0.1 
mm. The initial Size is 25.0 mm.

Increase the Size to move the designs further apart. Decrease the Size to move the designs 
closer together, and to overlap the designs.
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It is often desirable to adjust the Size until designs are touching or very close together when creating an 
embroidery, as this will reduce the number of movement stitches.

Shortcuts
�  Keys: Alt, M, VS

Mirror
Use Mirror  to reflect the designs to form pairs. Each alternate copy of the design is 
reflected.

Shortcuts
�  Keys: Alt, M, VM

Use the Multiply Vertical Options
1 In the View tab, ensure that the Canvas is set to 100mm x 100mm in size.
2 Load or draw a design.
3 Select the design with Box Select , Point Line Select , or Freehand Select .
4 Drag the design upwards and to the left to move it a short distance from the center of 

the canvas.
5 Click the Multiply tab.
6 In the Multiply tab, click Vertical .

The three repeated designs lie above and below the original, and the Multiply lines run 
horizontally.
The initial settings are 4 Repeats, with the Size of the Multiply zone set to 25.0mm.

7 Set the Size to 20mm, to reduce the size of the Multiply zone.
8 Click Mirror , half of your designs are now upside down!

Use Size to adjust the distance between your designs, and use Repeats to increase or 
decrease the number of designs.

9 In the Multiply mode section, click Tile .
Both the Horizontal and Vertical Options are now available.
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10 Increase both the Horizontal and Vertical number of Repeats 
to 5.
Your designs may show confusing overlapping.

11 Drag your original design into the center of the blue Multiply 
box.
If your design is larger than the box, there will still be some 
overlapping. 
Increase the Horizontal or Vertical Size to prevent overlapping.

12 Try using a different number of Repeats, and different settings 
for Size and Mirror with both the Horizontal and Vertical 
Options.

13 Click Apply Multiply  to place the multiplied designs on the 
canvas.
If you change to Circle  with a design in the center of the 
Canvas, all of the design copies will appear to collapse into the 
middle.
Drag your original design up and towards the left, and your designs will spread out around the circle.
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7Exporting Designs
Use the options on the Export tab to save your design as a picture, an embroidery, a 
design for a quilting robot, or for a cutter.

Use Export  to create the design in the desired format.

Exported File Type
Picture
Use Picture  to export your drawing in SVG, PNG or JPEG format. Click Export  to 
create the file.

Shortcuts
�  Export tab, Exported File Type: 
�  Keys: Alt, E, EP

Embroidery with Fills
Use Embroidery with Fills  to export your design as a filled embroidery. Use the 
Embroidery Options to choose the settings for the embroidered border, and the 
background fabric type to embroider on. Click Export  to create the file.

You can export embroideries as Husqvarna Viking / Pfaff .vp3, PREMIER+ .vp4, Brother/
Baby Lock/Bernina PES (.pes), Compucon/Singer PSW (.xxx), Janome/Singer (.jef ), Melco 
Expanded (.exp), and Tajima (.dst).

Shortcuts
�  Export tab, Exported File Type: 
�  Keys: Alt, E, EF

Embroidery Appliqué
Use Embroidery Appliqué  to export your design as an appliqué embroidery. Use the 
Embroidery Options to choose the settings for the embroidered border, and use the 
Appliqué Options to set the appliqué Method. Click Export  to create the file.

You can export embroideries as Husqvarna Viking / Pfaff .vp3, PREMIER+ .vp4, Brother/
Baby Lock/Bernina PES (.pes), Compucon/Singer PSW (.xxx), Janome/Singer (.jef ), Melco 
Expanded (.exp), and Tajima (.dst).

Settings for the selected File Type

Create your Exported file

Select a design type to Export

Selected File Type
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Shortcuts
�  Export tab, Exported File Type: 
�  Keys: Alt, E, EA

Embroidery Outlines
Use Embroidery Outlines  to export your design as an outline embroidery. Use the 
Embroidery Options to choose the settings for the embroidered border, and the 
background fabric type to embroider on. Click Export  to create the file.

You can export embroideries as Husqvarna Viking / Pfaff .vp3, PREMIER+ .vp4, Brother/
Baby Lock/Bernina PES (.pes), Compucon/Singer PSW (.xxx), Janome/Singer (.jef ), Melco 
Expanded (.exp), and Tajima (.dst).

Shortcuts
�  Export tab, Exported File Type: 
�  Keys: Alt, E, EO

Automated Quilting
Use Automated Quilting  to export your design as a file suitable for your quilting robot. 
Use the Quilting Options to set the line direction and type. Click Export  to create the 
file.

You can export quilting files in the following formats: 4D / 5D QuiltDesign Creator 4QB 
(*.4qb), QuiltSewClever / Quilt Artist / Shirley Stitcher QCC (*.qcc), PC Quilter (*.txt), Statler 
Stitcher (*.qli), AutoCAD (*.dxf ), HPGL (*.plt), CompuQuilter (*.cmd), CompuQuilter (*.cqp), 
Handi Quilter (*.hqf ) and IntelliQuilter (*.iqp).

Shortcuts
�  Export tab, Exported File Type: 
�  Keys: Alt, E, EQ

Cutting Machine
Use Cutting Machine  to export the design as an SVG, DXF or FCM image file for use in 
your cutter. The Cutter Options allow you to use the lines, fills, or lines and fills in your 
drawing. Click Export  to create the file.

The maximum size for the Brother ScanNCut FCM format is 12" x 12" (305mm x 305mm).
Recommended file formats for cutters:

Cutter Software Export Format

Cricut Explore® Cricut Design Space 3.1512 SVG (points)

KNK Zing Air® Make the Cut! 4.6.1 (Zing Plugin 2.1.0) SVG (points)

Silhouette Cameo® Silhouette Studio 3.6.57 ss
(Use "As Is" import settings)

DXF (millimeters)

Brother ScanNCut® (2) Direct to USB stick or machine FCM

Sizzix Eclips2 eCal2 2.203 SVG (points)
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Shortcuts
�  Export tab, Exported File Type: 
�  Keys: Alt, E, EC

Export
Click Export  to create a design in the chosen format. In the Save As dialog box, select a 
file type and click Save.

Shortcuts
�  Export tab, Exported File Type: 
�  Keys: Alt, E, X

Export a Design
1 Create a design.
2 Save the design. See “Save As” on page 16.
3 Select a project file type.
4 Click Export . The Export dialog box appears.
5 Select a format from the drop-down list.
6 Browse to the folder for your designs.
7 Click Save.

The design is saved in your chosen folder.

Embroidery Options
Use the Embroidery Options to choose the settings for the embroidered border, and the 
background fabric type to embroider on.

Fabric
Select the fabric to be used for your embroidery design. Click on the down arrow and 
select the desired fabric type. Choose from: Sheer, Woven, Knit, Fleece, Terrycloth. The 
initial fabric is Woven. The Fabric affects the compensation used for the design.

All stitches have a tendency to pull in. The pull varies according to fabric weight and type. Compensation is 
used to make a whole design or areas within it 'bolder' by increasing their relative size.

Shortcut
�  Keys: Alt, E, MF

Identical Line Type
Use Identical Line Type to create all border lines using the same color and Line Type.

When the Identical Line Type checkbox is checked (selected), the Line Type color and stitch type options 
become available.

Use same settings for all lines
Set the outline color

Choose a Fabric Background

Set Stitch Type for lines
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Shortcut
�  Keys: Alt, E, MI

Color
Set the color for all of your border lines. The color that you select replaces the initial color.

The colors for the fills in a filled embroidery are taken from the colors in the original drawing.

Shortcut
�  Keys: Alt, E, MC

Line Type
Select the stitch type to be used for the border of your embroidery. Choose from: Satin, 
Double and Quadruple line.

Shortcut
�  Keys: Alt, E, MT

Stitch Length
Select the Stitch Length for Double or Quadruple stitch. 

The available options are: 1.0mm, 1.5mm, 2.0mm, 2.5mm, 3.0mm, 3.5mm, 4.0mm, 5.0mm 
and 6.0mm. The initial value is 2.0mm.

Shortcut
�  Keys: Alt, E, ML

Satin Width
Set the width of a Satin line.

The available options are: 1.0mm, 1.5mm, 2.0mm, 2.5mm, 3.0mm, 3.5mm, 4.0mm, 5.0mm 
and 6.0mm. The initial value is 2.0mm.

Shortcut
�  Keys: Alt, E, MW

Appliqué Options
Select a Method for appliqué placement, and set the appliqué piece Margin.

Method
Choose the method for placing and securing the appliqué fabric.

�  Pre-cut Piece
Use a pre-cut appliqué piece; created, for example, using an automatic cutter or cutwork 
needles.

Match the size to the appliqué piece

Select an appliqué method

Set the appliqué margin
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Stitch a running line to show where the pre-cut appliqué piece should be placed, then 
stop to position the appliqué piece. Stitch down the appliqué piece with double stitch, 
then finish the edges with the selected border stitching.

�  Tack and Trim
Stitch a running line to show where appliqué fabric should be placed, then stop to 
position the fabric. Stitch down the appliqué fabric with double stitch, then stop so the 
fabric may be trimmed. Finish the edges with the selected border stitching.

Shortcut
�  Keys: Alt, E, AM

Margin
Select the margin for appliqué placement relative to the drawn border shape. 

The available options are: None, 0.5mm, 1.0mm, 1.5mm, 2.0mm, 2.5mm, 3.0mm, 4.0mm 
and 5.0mm. The initial value is 1.0mm.

Shortcut
�  Keys: Alt, E, AG

Match Placement Line
Adjust the position of the first running stitch line for either Tack and Trim or Pre-cut Piece 
so that it matches the outline of the appliqué piece after the appliqué piece Margin has 
been applied.

This may be useful for precise positioning of appliqué pieces that have been pre-cut with an automated 
cutter, to ensure the placement line is visible.

Shortcut
�  Keys: Alt, E, AP

Quilting Options
Use the Quilting Options to set the line direction and type for stitching on the quilting 
robot. The drawing is traced automatically unless As Drawn is selected.

Direction
Set the direction for the stitching. Choose from Unspecific (as drawn or traced), From Left 
or From Right.

Use From Left or From Right to start on one side and finish on the other. They are ideal for patterns that 
repeat along a quilted row.

Shortcut
�  Keys: Alt, E, QD

Set the direction of the stitching
Follow the lines exactly as drawn
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As Drawn
Select As Drawn to use the original lines exactly as drawn in the design.

When As Drawn is selected, hidden lines and lines drawn on top of other lines will be used 
in the design.

The automatic method traces the best path through the drawing. It does not trace lines hidden by fills.

Shortcut
�  Keys: Alt, E, QA

Cutter Options
Export the drawing as an SVG, DXF or FCM image file for use in a fabric cutter.

Set the units of measurement (millimeters or inches), and select a file type. Click Export  
to save the file.

Use
Use only the lines in the design, only the fills in the design, or both the lines and fills.

Shortcut
�  Keys: Alt, E, CU

As Drawn
Select As Drawn to use the original lines exactly as drawn in the design. Any hidden lines 
will be included in the design.

The automatic method traces the best path through the drawing. It does not trace lines hidden by fill areas.

Shortcut
�  Keys: Alt, E, CA

Follow the lines exactly as drawn
Use lines, fills, or lines and fills
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8Viewing Pictures and Designs
Use the View tab to set how you view the design, grid and background picture.

Canvas
Use the Width and Height settings for Canvas to set or change the size of the design area. 
Click Apply  to use the new settings.

Width
Set the Canvas Width from 20mm to 1000mm. The initial size is 100mm.

Shortcut
�  Keys: Alt, V, W

Height
Set the Canvas Height from 20mm to 1000mm. The initial size is 100mm.

Shortcut
�  Keys: Alt, V, HE

Apply
Use Apply  to use the new Canvas size.

Shortcut
�  Keys: Alt, V, A

Grid
Use the Grid functions to set the position and size of the grid, and to show or hide it.

Show Grid
Use Show Grid  to turn the background grid on and off. The grid may be used to help 
align objects and points.

Turn the background grid on or off using Show Grid.

The grid size is measured in pixels of the background picture, so the apparent grid size will vary according 
to the dimensions of the picture.

Show and adjust the grid Load, fade and remove a background

Measure an object or designSet the size of the Canvas
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Shortcuts
�  View Tab, Grid: 
�  Keys: Alt, V, SG

Grid Start
Choose a position for the start of numbering for the grid. Select Center or Top-Left from 
the drop-down menu. The initial Start position is Center.

Shortcut
�  Keys: Alt, V, GS

Grid Size
Choose the distance between the heavier grid lines.

The grid size is initially set to 5mm. Adjust its Size between 2 and 50mm, depending on 
what setting is most suitable for your screen resolution and design. Type in a figure and 
press ENTER (or use the up and down arrows to change the number). 

Shortcut
�  Keys: Alt, V, GR

Sub-divisions
Choose the distance between the pale grid lines.

Sub-divisions are initially set to 1/4. In the drop-down menu, choose from: None, 1/2, 1/3, 
1/4, 1/5, 1/6, 1/8, 1/10 or 1/16.

Shortcut
�  Keys: Alt, V, SU
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Background
Use an existing picture as a background on which to create a design. 

View Background
Use the Background slider bar to show, fade or hide the background picture in the Canvas. 
Change the view of the background picture to make it easier to see the lines and fills for 
the design.

Load Background
Use Load Background  in the View tab to open an existing picture as a background on 
which to create a design. PREMIER+ ECQ™ displays the Picture Viewer so you can choose 
which painting to open.

Load Background allows you to use picture formats that are not compatible with vector graphics as a 
background for freehand tracing.
Open a folder, and scroll down and click a picture to select it. Click Open to load the 
picture on the Canvas.

You can change the icon size, and show the names of the pictures.

Shortcuts
�  View tab, Background: 

Use Background On  to show 
the picture in the background.

Use Fade  to show the picture 
in the background with the colors 

faded by 50%.

Use Background Off  to hide the 
picture. 

Choose a picture folder

Click to select a picture

Scroll to view more folders

Load the selected picture
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�  Keys: Alt, V, L

Open a Picture as a Background
1 In the View tab, click File, click Load Background . The Picture Viewer appears. 
2 Browse through the drives and folders of the computer to the desired folder. 
3 Click on an icon to select the picture.
4 Click Open to load the picture into the Canvas.

Alternatively, double-click the icon for the picture.

Remove Background
Use Remove Background  to remove the current background picture from the canvas.

Alternatively, you can use Load Background  to select a different background picture.

Shortcuts
�  View tab, Background: 
�  Keys: Alt, V, R

Get Length
Use Get Length  to measure the distance between any two points on the canvas. Click 
the Get Length icon  and the mouse pointer changes to the Measure pointer . Then 
click and drag a line across the design. The length of the line is displayed.

For example, use this to obtain the width of a design, or the distance between two 
sections.

The length is shown in millimeters or inches, according to the setting for Show Measurements in 
Preferences. The alternative units are shown in parentheses.

Shortcuts
�  View Tab: 
�  Keys: Alt, V, GL

Measure a Distance with Get Length
1 In the View tab, click the Get Length  icon. The pointer changes to 

the measure pointer .
2 Click and drag across the part of the design you want to measure. A 

line will show the length you are measuring, and a tooltip displays the 
distance.
If desired, make a note of the number.

3 Repeat the click and drag to measure any other distances, as required.
4 Right-click to deselect the function.
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Zoom Commands
A number of functions are available to make it easier to navigate around designs. These 
include the Zoom functions and the Overview Window. By default, each design is shown 
at a size so that the grid fills the window, the same as if you click Zoom To Canvas  after 
zooming in or out.

Shortcuts

Zoom To Rectangle
Use Zoom To Rectangle  to enlarge the view of an area of the design.

Click the Zoom To Rectangle icon  to the right of the status bar, and the mouse pointer 
changes to the zoom in pointer . Then either click a point on the design you want to 
zoom in towards, or click and drag a rectangle around the area you want to enlarge and 
release the mouse button to zoom.

Zoom To Rectangle is automatically deselected after you have used it.

Shortcuts
�  Status Bar: 
�  Keys: Ctrl + 0

If you have a wheel mouse, hold the Ctrl key and move the wheel to zoom.

Pan Mode
Use the Pan feature to move around the screen easily. The Pan feature works when you are 
Zoomed In on part of the screen, making the scroll bars visible at the right and bottom of 
the Canvas.

Hold the Space key down until the pan cursor  appears, then click and drag.

The pan occurs in real time, that is you see the canvas move as you drag across the screen.

Pan Around the Canvas
1 Click Zoom To Rectangle  and the arrow pointer changes to the zoom in pointer .

Zoom Out Keys: Ctrl + -

Zoom To Rectangle Keys: Ctrl + 0

Zoom In Keys: Ctrl + =

Zoom To Canvas Keys: Ctrl + 9

Zoom To Designs Keys: Ctrl + 8

Click and drag to zoom in on an area

Zoom to Canvas
Drag to zoom in and out

Click to zoom in instantly
Click to zoom out instantly

Select or input percentage zoom
100% zoom

Zoom to Designs
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2 Click and drag to draw a box, then release to zoom in. Scroll bars appear to allow you to move around 
the screen at this higher zoom level.

3 Hold the Space key down, then start to click and drag. The pan cursor  appears.
4 Click and drag until the pointer is in the desired part of the screen. (If you have a wheel mouse, you 

can click the wheel to pan around the screen.)
5 Lift the pen or release the mouse button.

Zoom To Canvas
Use Zoom To Canvas  to view the whole work area. Click the Zoom To Canvas icon  
and the view will zoom in or out to show the Canvas in the window.

Shortcuts
�  Status Bar: 
�  Keys: Ctrl + 9

Zoom to Designs
Use Zoom to Designs  to zoom to the selected designs, or to all designs on the canvas. 
Click the Zoom To Designs icon  and the view will zoom in or out to show the selected 
designs, or all designs on the canvas.

Shortcuts
�  Status Bar: 
�  Keys: Ctrl + 8

Zoom by Percentage
Use the drop-down list in the Status Bar to set percentage levels to zoom in from 10% up 
to 800%. Alternatively, enter a number in the percentage text box.

Select 100% to display the design at a magnification as close as possible to the Real Size setting you chose 
in Preferences.

Zoom Bar
Use the Zoom Bar to zoom in or out from the center of the picture or design.

The Zoom Bar is on the right side of the Status Bar.

Use the slider to zoom in or out of the picture or design, or click on the Zoom Out  or 
Zoom In  icons.
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9Preferences
Use Preferences  to select the Background, Grid and Surround colors, to set the theme 
for your PREMIER+ ECQ™, to set the screen size measurements, and choose the default 
Export thread range. When these are changed, the new settings will be remembered 
when PREMIER+ ECQ™ is closed and reopened.

Shortcut
�  File Menu: 

Colors

Color
Set the background color for your PREMIER+ ECQ™ software to 
whatever you prefer. Click on the down arrow next to the Color block 
and a palette of 40 colors appears. Move the pointer over the Color 
palette until the color you prefer is highlighted, then click again. 
Alternatively, select More Colors and the Colors window appears to 
allow you to choose any color from the 16 million colors of the 
Windows Color Matrix (see “Colors Dialog Box” on page 20). The color 
set by default for your PREMIER+ ECQ™ software is 230, 245, 255 (RGB).

When you change the Background Color the new color is immediately applied to the canvas in PREMIER+ 
ECQ™.

Grid Color
Set the grid color for your PREMIER+ ECQ™ software to whatever you prefer. Click on the 
down arrow next to the Color block and a palette appears of 40 colors. Move the pointer 
over the Color palette until the color you prefer is highlighted, then click again. 
Alternatively, select More Colors and the Colors window appears to allow you to choose 
any color from the 16 million colors of the Windows Color Matrix (see “Colors Dialog Box” 

Set the background color

Show the Rulers around the canvas

Set the grid color
Preview the background color and grid color

Set the screen color and style
Set real size measurements for designs

Set the units of measurement

Set the Surround color

Choose the thread range for Exporting



PREMIER+ ECQ™   Preferences              83

on page 20). The color set by default for your PREMIER+ ECQ™ software is 85, 150, 185 
(RGB).

Surround
The Surround color is the color used outside the grid boundaries. Set the Surround color 
for your PREMIER+ ECQ™ software to whatever you prefer. Click on the down arrow next to 
the Color block and a palette appears of 40 colors. Move the pointer over the Color palette 
until the color you prefer is highlighted, then click again. Alternatively, select More Colors 
and the Colors window appears to allow you to choose any color from the 16 million 
colors of the Windows Color Matrix (see “Colors Dialog Box” on page 20). The color set by 
default for your PREMIER+ ECQ™ software is 210, 210, 210 (RGB).

Canvas Preview
Use the preview to assess the appearance of the grid color and the selected background 
colors.

Styles
Set the theme for the main windows in your PREMIER+ ECQ™ to whatever you prefer. Click 
on the down arrow and choose the desired theme. The default theme for your PREMIER+ 
ECQ™ software is Office 2010 Blue.

Measurements

Real Size
Use the on-screen ruler to adjust the settings so that your PREMIER+ ECQ™ software can 
display designs at their real-world size. 

The real size measurement is 100% on the zoom bar.
Hold a ruler against the screen and measure the number of millimeters that correspond to 
the length of the on-screen ruler. Type this number in the box, then click OK (or press 
ENTER). The program will close. When you reopen your PREMIER+ ECQ™ software, designs 
will be displayed at real size if 100% is selected on a zoom Slider.

If a design is too large to be shown at Real Size in a window, the percentage size will be displayed.

Show Measurements In
Select whether to show and enter measurements in millimeters or inches.

This may be overridden for printing. When Inches is selected, inches are shown as decimal values. Fractions 
may be used to enter measurements.
The alternative units will be shown when you hover the pointer over a measurement. You may also enter 
the alternative measurement with units of mm or " (including fractions) and it will be automatically 
converted. For example, ¼" will be converted to 6mm.
Measurements are initially set to be shown in millimeters.

Rulers
Hide or show the rulers around the left and top sides of the canvas.
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Export

Export Thread Range
Select the palette that will be active when saving embroidery files in your PREMIER+ ECQ™ 
software. Choose from the following Thread Manufacturers: Robison-Anton Rayon 40, 
Isacord Poly 40, Isafil Rayon 40, Madeira PolyNeon 40, Madeira Rayon 40, Robison-Anton 
Poly 40, Sulky Poly Deco 40, Sulky Rayon 40. Click the down arrow and the list of options 
appears. Select the desired option by clicking on it.

The thread range is initially set to Robison-Anton Rayon 40.
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10Utilities
Use the utilities in the Help and title bar menus to check for updates, manage your 
registration, deactivate and reset your PREMIER+ ECQ™ installation. 

Check for Update
Use Check for Update  in the Help tab to check for any updates to your PREMIER+ ECQ™ 
installation.

You are either told that your software is up-to-date, or any available updates are 
downloaded and installed.

Shortcut
�  Keys: Alt, H, C

Modify Registration Details
Use Modify Registration Details  in the Help tab to make changes to your software 
registration, for example to update your address or change your dealer. Enter your email 
address and password to access your account. 

Shortcut
�  Keys: Alt, H, M

Deactivate
Use Deactivate  in the Help tab to reclaim the activation code on a computer before 
installing on another computer. Enter your email address and password to access your 
account. You can Deactivate in the Activation page of your registration.

Shortcut
�  Keys: Alt, H, D

Reset Module
Use Reset Module to return PREMIER+ ECQ™ to its original settings. Some settings are 
changed immediately, others are reset when you next restart.

To access Reset Module, click the PREMIER+ ECQ™ icon in the title bar, or right-click the 
title bar, then choose Reset Module from the menu.

Use Reset Module with an empty Canvas, as any work on the screen may be significantly changed when 
Reset Module is used.
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11Troubleshooting

Error Messages
Acquiring and Loading Pictures

"Could not load picture file."
This message could appear if the desired picture is not where the module expects it to be, 
for example if it was loaded from a USB stick, then closed and the USB stick removed. It 
could also appear if the file you are attempting to load is corrupt. For example, it might 
have an extension such as .bmp or .jpg, yet not be a proper picture file.

Saving Files

"Error saving picture."
This message appears on attempting to save the picture and the picture is not saved. For 
example, if you attempt to overwrite an existing picture that is read only or if you attempt 
to save the picture to a read only location such as a CD-ROM.

Exporting Files

"Cannot export design."
This message appears if you try to use the Export function when there is no information to 
export.

"Cannot save file."
The program cannot save the file. Ensure that the disk where you are trying to save the 
design is not write-protected, then try again.

"You can’t save here. Please choose another location."
This message appears if, for instance, you have loaded a drawing from a CD-ROM and then 
attempt to save the embroidery back to the CD. A CD-ROM is read only, therefore you will 
not be able to save the embroidery.

"Design File is read-only. Cannot continue."
This will happen if you attempt to open a design that has been set as read-only, or is read-
only because it is stored on a CD-ROM. If the design file is on your hard disk as read-only 
then you must change its properties in Windows® Explorer so that it is no longer read-only. 
For designs on CD-ROMs, use Windows® Explorer to copy them to your hard disk, then 
change the properties so that they are no longer read-only. (Windows® Explorer Help has 
information on the read-only attribute.)
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"Filename already exists. Do you want to replace it?"
This happens when you are doing a Save As on the .ecq design file and you have given the 
name of a file that is already there. Click Yes or No as appropriate. You may have to replace 
a file several times if you are creating stitch files to stitch out tests of your design.

"Disk is write-protected. File not saved"
This will happen if you try to save a file to a floppy disk that has the write-protect tab open. 
Either take out the floppy disk and close the write-protect tab, or use a different floppy 
disk.

Miscellaneous

"Error. Not enough memory to perform operation."
This message will appear when system resources are low. Close other programs and try 
again. If this does not work, try restarting your computer.
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Other Topics
Screen Appearance

"Some of the icons in the Ribbon bar are 'grayed out'."
Certain icons (for example Cut on the Draw tab) are only highlighted once a design is 
shown on the screen. Also, when there is a design on the screen, some functions that 
might cause a mismatch between the size of the design and the size of the picture are not 
available in the Picture window.

"I have changed grid color and spacing and now I wish to return to the 
original settings."
Use Preferences to change the grid color. Follow the instructions in the Preferences 
section and select Mid Blue (RGB values 85, 150, 185) from the standard color drop-down 
on the Grid Color button.

Use the Size setting on the View tab to change the grid spacing. Set the Grid Size to 10.

"I have changed the screen background color and now I wish to return to 
the original light blue."
Use Preferences to change the background color. Follow the instructions in the 
Preferences section and select the RGB values 230, 245, 255 in the Colors dialog box.

Loading Pictures

"I loaded a small picture, and it has too many jagged lines."
Although the program automatically doubles the size of a picture if its height and width 
are less than 500 pixels, this may still produce jagged lines. For a smoother effect, rescan 
the picture.

Editing the Design

"I did not select all the objects I wanted with Box, Point Line or Freehand 
Select."
Objects must be fully enclosed by the selection line to be selected as part of a block. If 
even the smallest part of an object is outside the line then it will not be selected.

"Color Tolerance does not show me all the lines that will be traced by a 
Trace function."
The dashed line used by Color Tolerance only shows the outside of the area that is 
selected by the current Color Tolerance value. Simply try the Trace function and if the 
result is not satisfactory then Undo the result and retry the trace with a higher Color 
Tolerance.
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12Quick Reference Guide

Ribbon Tabs

File Tab/Menu
New Clear the screen ready to create or load a new design.

Ctrl + N

New Window Open an additional PREMIER+ ECQ™ window.
Ctrl + Shift + N

Open Open an existing design, replacing the design on the screen.
Ctrl + O

Save Save the design with the same name.
Ctrl + S

Save As Save the design under a new name.
Ctrl + Shift + S

Insert Insert an existing design into your current project.
Ctrl + I

Recent Open recently used designs.

Preferences Set the stitch and screen options.

Exit Close the current window and prompt to save new and changed designs.
Alt + F4
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Draw Tab
Clipboard Section

Select Section

Clipboard
Copy Copy the selected objects to the clipboard, without affecting the current 

selection.
Ctrl + C; Alt, D, CC

Paste Paste the objects on the clipboard back into the design.
Ctrl + V; Alt, D, PA

Cut Cut out the selected objects and place them on the clipboard.
Ctrl + X; Alt, D, CU

Duplicate Make a copy of the selected objects, which is automatically pasted on the 
Canvas below and to the right of the original.
Alt, D, CD

Delete Delete the selected object or the last object in the design.
Delete; Alt, D, CX

Select
Object Select Click on the object that you want to select. 

Alt, D, O

Box Select Select a block of objects by drawing a rectangle.
Alt, D, B

Freehand Select Select a block of objects by drawing a line around the required objects.
Alt, D, F

Point Line Select Select a block of objects by clicking a series of points to create an irregular 
outline of straight or curved lines around the required objects.
Alt, D, PS

Select All Select all visible objects as a single block.
Ctrl + A; Alt, D, SA

Select None Deselect all of the objects in the work area, including any outside the grid.
Ctrl + Shift + A; Alt, D, SN

Replace 
Selection

Replace the currently selected objects with the new selection.
Alt, H, RS

Add To 
Selection

Add the new selection to the currently selected objects.
Alt, H, A

Remove From 
Selection

Remove the new selection from the currently selected objects.
Alt, H, RF
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Combine Section

Group Section

Snap Section

Combine
Make Holes Create a hole within the selected objects.

Alt, D, MH

Uncombine Break apart an object combined using Make Holes. Any holes in fill areas will 
be removed.
Alt, D, UN

Group
Group Group all selected objects together.

Ctrl + G; Alt, D, GG

Ungroup Separate the objects, or groups, within the selection.
Ctrl + U; Alt, D, GU

Ungroup All Split all the groups within the selected group into their individual objects.
Alt, D, GA

Snap
Snap to Grid Align objects to the Grid lines when drawn or moved.

Alt, D, NG

Snap to Line Snap to an existing drawn line when drawing.
Alt, D, NL
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Insert Tab 
Shape Section

Lettering Section

Design Section

Shapes Select a Shape from the gallery.
Alt, I, P

Insert Shape Add a shape to the drawing.
Alt, I, S

Font Choose a font on your computer.
Alt, I, O

Style Choose a font Style.
Alt, I, W

Size Set the font size in points.
Alt, I, I

Alignment Align the lettering Left, Center or Right.
Left: Alt, I, AL
Center: Alt, I, AC
Right: Alt, I, AR

Insert Lettering Add text to your design.
Alt, I, L

Design Gallery Add a drawing from the Design Gallery.
Alt, I, M

Insert File Insert a drawing into your design.
Alt, I, F
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Multiply Tab
Multiply Mode Section

Circle Options Section

Horizontal Options Section

Vertical Options Section

Enable Multiply Activate the Multiply options.
Alt, M, E

Apply Multiply Place the multiplied designs on the canvas.
Alt, M, A

Cancel Multiply Cancel the current Multiply.
Alt, M, N

Circle Multiply designs in a circle.
Alt, M, MC

Horizontal Multiply designs along a horizontal line. 
Alt, M, MR

Vertical Multiply designs along a vertical line.
Alt, M, MV

Tile Multiply designs within a horizontal and vertical grid.
Alt, M, MC

Repeats Set the number of repeats for the multiplied circle.
Alt, M, CR

Mirror Reflect the designs to form pairs.
Alt, M, CM

Alternative 
Mirror

Reflect the designs with a rotated axis.
Alt, M, CA

Repeats Set the number of repeats for the multiplied line.
Alt, M, RR

Size Set the width of the Multiply area.
Alt, M, RS

Mirror Reflect the designs to form pairs.
Alt, M, RM

Repeats Set the number of repeats for the multiplied line.
Alt, M, VR

Size Set the height of the Multiply area.
Alt, M, VS

Mirror Reflect the designs to form pairs.
Alt, M, VM
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Export Tab
Exported File Type

Picture Export your drawing in SVG, PNG or JPEG format. 
Alt, E, EP

Embroidery with 
Fills

Export your design as a filled embroidery.
Alt, E, EF

Embroidery 
Appliqué

Export your design as an appliqué embroidery. 
Alt, E, EA

Embroidery 
Outlines

Export your design as an outline embroidery. 
Alt, E, EO

Automated 
Quilting

Export your design as a file suitable for your quilting robot.
Alt, E, EQ

Cutting Machine Export the design as an SVG, DXF or FCM image file for use in your 
cutter. 
Alt, E, EC

Export Create a design in the chosen format.
Alt, E, X

Embroidery Options
Fabric Choose a background fabric.

Alt, E, MF

Identical Line 
Type

Create all border lines using the same color and Line Type.
Alt, E, MI

Color Set the color for your border lines.
Alt, E, MC

Line Type Select the stitch type to be used for the border of your embroidery.
Alt, E, MT

Stitch Length Select the Stitch Length for Double or Quadruple stitch.
Alt, E, ML

Satin Width Set the width of a Satin line.
Alt, E, MW

Appliqué Options
Method Choose the method for placing and securing the appliqué fabric.

Alt, E, AM

Margin Select the margin for appliqué placement relative to the drawn 
border shape.
Alt, E, AG

Match 
Placement Line

Adjust the position of the first running stitch line.
Alt, E, AP

Quilting Options
Direction Set the direction for the stitching.

Alt, E, QD

As Drawn Use the original lines exactly as drawn in the design.
Alt, E, QA
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Cutter Options
Use Use lines, fills or both.

Alt, E, CU

As Drawn Use the original lines exactly as drawn in the design.
Alt, E, CA
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View Tab
Canvas Section

Grid Section

Background Section

Length Section

Canvas
Width Set the width of the Canvas.

Alt, V, W

Height Set the height of the Canvas.
Alt, V, HE

Apply Apply your changes.
Alt, V, A

Grid
Grid Show or hide the background grid, and set its size.

Alt, V, SG

Grid Start The start position of the Grid, Center or Top-Left.
Alt, V, GS

Grid Size The Grid size.
Alt, V, GR

Sub-divisions Alt, V, SU

Background
Fade Use the slider to Hide, Fade or Show the background image.

Load 
Background

Open an existing picture as a background on which to create a design. 
Alt, V, L

Remove 
Background

Remove the current background picture from the canvas.
Alt, V, R

Get Length Measure the distance between any two points on the Canvas.
Alt, V, GL
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Help Tab 
Help Topics List help topics.

F1; Alt, H, H

Inspiration and 
Support

Use the Internet to access inspiration and answers about the software.
Alt, H, I

Check for Update Check for updates to your software.
Alt, H, C

Modify Registration 
Details

Change your registration details.
Alt, H, M

Deactivate Deactivate your software, for example to move it to another computer.
Alt, H, D

About PREMIER+ 
ECQ™

Display program information, version number and copyright.
Alt, H, A
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FilmStrip
FilmStrip Items

Object
Each object is represented graphically. 

Object Type
The name of the object type is shown.

Object Name
The name of the object is shown.

Layout Order
Move Forwards Bring one step closer to the front of the design.

Move Backwards Bring one step closer to the back of the design.

Move to Front Place at the front of the design.

Move to Back Place at the back of the design.
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Design Panel
Line Section

Fill Section

Draw Section

Points Section

Line Color Click to change the line color.

Pick Line Color Select a color from the picture and make it the line color.

No Line No line is placed around a fill.

Swap Colors Switch the line and fill colors.

Line Width Choose a width for your line.

Fill Color Click to change the fill color.

Pick Fill Color Select a color from the picture and make it the fill color.

No Fill No fill is placed within an area.

Freehand Draw Click and drag to draw a line.

Point Draw Click points to create a line.

Bezier Draw Use Bezier drawing to create a line.

Trace Line Trace the outline of a background picture to create a line drawing.

Trace Area Trace a background picture with no outline to create a filled drawing, 
or a line drawing.

Trace Area & Hole Trace an area of a background picture the includes a hole to create a 
filled drawing, or a line drawing.

Edit Points Use Edit Points to enable the moving and editing of an object’s points 
if another function is being used. 

Insert Points Add a new point to the currently selected line.

Delete Points Delete points from the currently selected line.

Knife Slice the selected objects along the line you draw.

Join Join two open lines together.

Convert Points 
to Curve

Change the selected point in a Bezier line to a Curve point.

Convert Points 
to Corner

Change the selected point in a Bezier line to a Corner point.
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Edit Section
Rotate 45 Rotate the selected block of objects by 45 degrees.

Transform Use the Transform dialog to show and change the size, rotation and 
skew of the currently selected block.

Center in Canvas Move the selected objects to the center of the Canvas.

Horizontal 
Alignment

Align Left
Align all selected objects on the left edge.

Align Center
Center align all selected objects horizontally.

Align Right
Align all selected objects on the right edge.

Distribute Horizontally
Align all selected objects to be equally spaced horizontally.

Vertical 
Alignment

Align Top
Align all selected objects on the top edge.

Align Middle
Center align all selected objects vertically.

Align Bottom
Align all selected objects on the bottom edge.

Distribute Vertically
Align all selected objects to be equally spaced vertically.

Convert to Point 
Line

Change the selected Bezier Line to a Point Line.

Convert to Bezier 
Line

Change the selected Point Line to a Bezier Line.
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Toolbars
Quick Access Toolbar

Status Bar
Use the Zoom Commands on the Status Bar to navigate around designs.

Insert Insert an existing design into your current project.
Ctrl + I; Alt, 1

Save Save the design with the same name.
Ctrl + S; Alt, 2

Save As Save the design under a new name.
Ctrl + Shift + S; Alt, 3

Undo Undo the last action.
Ctrl + Z; Alt, 7

Redo Redo the previously undone action.
Ctrl + Y; Alt, 8

Zoom To 
Rectangle

Increase magnification of an area of the design.
Ctrl + 0

Zoom To 
Canvas

Fit work area to screen.
Ctrl + 9

Zoom to 
Designs

Zoom to the selected designs.
Ctrl + 8

100%
Display picture at 100% magnification.
Ctrl + 1

200%
Display picture at 200% magnification.
Ctrl + 2

400%
Display picture at 400% magnification.
Ctrl + 3

800%
Display picture at 800% magnification.
Ctrl + 4

75%
Display at 75% magnification.
Ctrl + 5

50%
Display at 50% magnification.
Ctrl + 6
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25%
Display at 25% magnification.
Ctrl + 7

Zoom Out Decrease magnification.
Ctrl + -

Zoom In Increase magnification.
Ctrl + =
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Index
A
About the Program............................................... 2
Acrobat Reader® .................................................... 1
Add

Points.............................................................39
Add To Selection..................................................47
Align

Bottom..........................................................54
Center............................................................53
Left .................................................................53
Middle...........................................................54
Right ..............................................................53
Top..................................................................54

Alignment
Horizontal ....................................................53
Tools...............................................................53
Vertical ..........................................................53

All
Select.............................................................47
Ungroup.......................................................57

Alter Color in Color Box.....................................18
Angled

Line ................................................................23
Append

To a Line .......................................................37
Appliqué Options................................................73
Apply Multiply.............................................. 62, 93
Area

Color ..............................................................99
Create............................................................99
Deselect........................................................46
Edit .................................................................36
Get Length Of.............................................79
Group ............................................................54
Select.............................................................43

Areas
Select and Resize ......................................60

B
Background...........................................................78
Background Colors .............................................82
Background Picture

Open..............................................................78
Backwards

Move..............................................................58
Bar

Ribbon ............................................................ 3
Scroll ..............................................................57
Status............................................................... 5
Title ............................................................. 3, 5
Zoom .............................................................81

Bezier Draw ...........................................................23
Bezier Mode

Convert Points............................................40
Block

Cut ..................................................................42
No Handles..................................................44

Block of Objects
Delete............................................................52
Horizontally Mirror ...................................50
Mirror.............................................................50

Modify........................................................... 48
Move..............................................................48
Nudge ........................................................... 48
Resize ............................................................ 48
Rotate............................................................ 50
Select.............................................................43
Skew ..............................................................49
Vertically Mirror......................................... 50

Bold..........................................................................33
Bold Italic ...............................................................33
Bottom

Align ..............................................................54
C
Cancel Multiply.............................................62, 93
Canvas................................................................ 5, 76
Canvas Preview....................................................83
Center

Align ..............................................................53
Of Rotation...........................................48, 50

Change
Line Color ....................................................22
Sequence of Objects ............................... 58

Check for Update ................................................ 85
Choose

Drawing Colors..........................................18
New Drawing Color..................................20

Circle.................................................................63, 93
Draw ..............................................................32

Circle Options.......................................................93
Clipart

Export as ......................................................15
Close the Program .................................................2
Closed

Line ................................................................29
Color ........................................................................82

Area................................................................99
Change Line................................................ 22
Choose New Drawing ............................. 20
Grid ................................................................82
Line or Fill ....................................................20
Models .......................................................... 20
Palette........................................................... 18
Panel.................................................................4
Pick.................................................................18
Surround......................................................83

Color Box................................................................18
Alter Color ................................................... 18

Colors
Choose Drawing........................................ 18
Dialog Box ................................................... 20
Line and Fill ................................................. 18

Convert Points......................................................40
Convert Points to Corner..................................40
Convert Points to Curve....................................40
Convert to Bezier Line....................................... 41
Convert to Point Line......................................... 41
Copy.........................................................................60

Objects .........................................................52
Picture........................................................... 60

Create
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Area................................................................99
Lettering.......................................................33
Pictures ........................................................... 1

Curved
Line ................................................................23

Curved Line
Reshaping....................................................37

Cut ............................................................................60
Block ..............................................................42
Group ............................................................42
Line ................................................................42
Objects..........................................................52
Picture...........................................................60

Cutter Options......................................................75
D
Deactivate..............................................................85
Decimal Inches.....................................................83
Delete ......................................................................52

Block of Objects.........................................52
Points.............................................................38

Deselect
Selection ......................................................44
Wrong Area .................................................46

Design
Choices ........................................................... 1
Load with Drag and Drop ......................15
Pasting and Inserting ..............................44

Design Gallery ......................................................34
Designs

Load ...............................................................34
Open Recently Used ................................15
Save................................................................16
View ...............................................................76

Desktop Shortcuts ................................................ 2
Distribute

Horizontally.................................................53
Vertically.......................................................54

Double-headed Arrow
Colors ............................................................19

Drag and Drop to Load Design ......................15
Draw.........................................................................17

Circle..............................................................32
Freehand......................................................22
Point ..............................................................22
Shapes ..........................................................32
Square...........................................................32

Draw a Circle in Bezier Mode ..........................24
Draw a Flower using Bezier Curves...............26
Draw Tab......................................................... 28, 90
Drawing

Insert .............................................................13
Drawing Color

Choose..........................................................18
Choose New................................................20

Drawing Panel ........................................................ 4
Edit Area.......................................................36
Group Area ..................................................54
Select Area...................................................43

Duplicate................................................................60
E
Edit

Pictures .........................................................36
Points.............................................................36

Edit a Bezier Line .................................................25

Edit Window
FilmStrip.......................................................98

Editing
Individual Lines ......................................... 36
Tools ..............................................................36

Embroidery
Files...................................................................8

Embroidery Options ..........................................72
Enable ..................................................................... 62
Enable Multiply....................................................62
Error Messages.....................................................86
Existing Line

Change Color .............................................22
Exit...............................................................................2
Explorer ..................................................................15
Export...................................................................... 70

Clipart ........................................................... 15
Export Thread Range ......................................... 84
Exported File Type ..............................................70
Exporting Designs ..............................................70
F
FAQs............................................................................1
File

Formats ...........................................................7
Name......................................................13, 14

File Menu ...............................................................89
File Tab .................................................................... 89
Files

Embroidery ....................................................8
Picture..............................................................7

Files of Type....................................................13, 14
Fill

Change Properties....................................21
Properties ....................................................21

Fill Color
Pick.................................................................19

FilmStrip .................................................... 5, 57, 98
Items.......................................................57, 98
Open Group................................................ 58
Select Object ..............................................58

Finding Information..............................................1
First Visible Object ..............................................58
Font..........................................................................33
Formats of Files.......................................................7
Forwards

Move..............................................................58
Freehand

Draw ..............................................................22
Select.............................................................45

Freehand Point
Select.............................................................46

G
Gallery Designs

Group ............................................................ 55
Get Length.............................................................79
Getting Started .......................................................1
Grid ..........................................................................76

Snap to ..................................................29, 78
Grid Color...............................................................82
Group ...................................................................... 54

Area................................................................54
Cut..................................................................42
Open in FilmStrip......................................58

Grouping Selected Objects ............................. 54
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H
Handle

Rotation........................................................50
Round............................................................50
Square...........................................................48
Trapezoidal..................................................49
Triangular.....................................................50

Help............................................................................ 1
Help Tab..................................................................97
Horizontal ...................................................... 63, 93

Alignment....................................................53
Horizontal Options .............................................93
Horizontally

Distribute .....................................................53
Mirror Block.................................................50

Hue Saturation Luminance (HSL)
Color Model ................................................20

I
Inches .............................................................. 79, 83
Information

Finding............................................................ 1
Readme and Technical .............................. 1

Insert
Designs .........................................................44
Drawing........................................................13

Insert File................................................................35
Insert Points ..........................................................39
Insert Tab................................................................32
Internet FAQs.......................................................... 1
Italic..........................................................................33
J
Join ...........................................................................37

Lines...............................................................29
K
Knife Tool................................................................42
L
Layout Order................................................. 58, 98
Left

Align ..............................................................53
Length

Of Area..........................................................79
Lettering

Create............................................................33
Line...........................................................................36

Angled Section ..........................................23
Appending to.............................................37
Change Color..............................................22
Change Properties....................................21
Closed ...........................................................29
Curved ..........................................................23
Cut ..................................................................42
Edit .................................................................36
None..............................................................18
Properties ....................................................21
Smoothness ........................................ 22, 37
Smoothness Options ...............................22
Snap to.................................................. 29, 37
Straight .........................................................23

Line and Fill Colors..............................................18
Line Color ...............................................................18
Line or Fill Color ...................................................20
Lines

Joining ..........................................................29

Load Design with Drag and Drop .................15
Look In .............................................................13, 14
M
Main Toolbar .......................................................101
Make Holes............................................................ 59
Manage

Pictures.........................................................13
Match

Line Color ....................................................22
Measure

Background ................................................ 79
Design........................................................... 79

Measurements .....................................................83
Units ..............................................................79

Menu
File..................................................................89
Start ..................................................................2

Messages................................................................86
Middle

Align ..............................................................54
Millimeters.............................................................79
Minimal Smoothing

Line ................................................................22
Mirror

Block of Objects ........................................ 50
Horizontally ................................................ 50
Vertically ......................................................50

Mode
Pan .................................................................80

Modify
Block of Objects ........................................ 48

Modify Registration Details............................. 85
Module

Reset..............................................................85
Move

Backwards ................................................... 58
Block of Objects ........................................ 48
Center of Rotation .............................48, 50
Forwards ......................................................58
To Back.......................................................... 58
To Front ........................................................58

Multiply ..................................................................62
Reflect Options..........................................66
Rotate Options...........................................64

Multiply Mode...............................................62, 93
Multiply Tab .......................................................... 93
N
Name

File...........................................................13, 14
New Drawing Color............................................20
No Handles

Block..............................................................44
No Line.................................................................... 18
Nodes

Point Draw................................................... 22
None

Select.............................................................47
Nudge

Block of Objects ........................................ 48
O
Object...................................................................... 98

FilmStrip.......................................................57
First Visible .................................................. 58
Select.............................................................45
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Select in FilmStrip .....................................58
Type ....................................................... 57, 98

Object Select.........................................................44
Objects....................................................................36

Change Color..............................................51
Change Sequence ....................................58
Copy...............................................................52
Cut ..................................................................52
Delete Block................................................52
Grouping......................................................54
Mirror Block.................................................50
Modify Block ...............................................48
Move Block..................................................48
Nudge Block ...............................................48
Paste ..............................................................52
Resize Block.................................................48
Rotate Block................................................50
Select Block.................................................43
Selecting ......................................................43
Skew Block ..................................................49

Online Help ............................................................. 1
On-screen Pointers ............................................... 6
Open........................................................................14

Background Picture..................................78
Recently Used Designs............................15

Options
Line Smoothness.......................................22

Order
Layout ...........................................................58

Other Topics ..........................................................88
P
Paint and Draw.....................................................17
Palette Color..........................................................18
Pan Mode...............................................................80
Panel

Color ................................................................ 4
Drawing.......................................................... 4

Parts of Software Window.................................. 3
Paste.........................................................................60

Objects.................................................. 44, 52
Picture...........................................................60

Pasting Block
Object Select ..............................................44

Paths
Combine.......................................................59

Percentage Zoom................................................81
Pick

Color ..............................................................18
Fill Color........................................................19

Picture .....................................................................78
Copy...............................................................60
Cut ..................................................................60
Files .................................................................. 7
Load ...............................................................14
Open as Background ...............................78
Paste ..............................................................60

Picture Window...................................................... 4
Pictures

Create.............................................................. 1
Edit .................................................................36
Manage.........................................................13
View ...............................................................76

Piece
Pre-cut ..........................................................73

Point

Draw ..............................................................22
Point Draw.............................................................22

Nodes............................................................ 22
Pointers......................................................................6
Points.......................................................................36

Add ................................................................39
Delete............................................................ 38
Edit .................................................................36
Number in Point Draw ............................22
Round ........................................................... 36
Square........................................................... 36

Points Section.......................................................99
Pre-cut Piece.........................................................73
Preferences............................................................ 82

Show Measurements............................... 79
Properties

Fill ...................................................................21
Line ................................................................21

Q
Quick Access Toolbar .......................................101
Quick Reference Guide .....................................89
Quilting Options.................................................. 74
R
Readme......................................................................1
Real Size..................................................................83
Recently Used Designs......................................15
Red Green Blue (RGB) Color Model ..............20
Redo.........................................................................61
Reference ...............................................................89
Reference Guide.....................................................1
Reflect

Options with Multiply ............................. 66
Registration

Modify........................................................... 85
Regular.................................................................... 33
Remove Background ......................................... 79
Remove From Selection....................................48
Replace Selection................................................ 47
Reset Module........................................................85
Reshaping

Curved Line................................................. 37
Resize

Areas..............................................................60
Block of Objects ........................................ 48

Ribbon
Bar .....................................................................3

Ribbon Tabs........................................................... 89
Right Align.............................................................53
Root..........................................................................58
Rotate

Block of Objects ........................................ 50
Move Center ........................................48, 50
Options with Multiply ............................. 64

Rotate 90................................................................51
Rotation

Handle .......................................................... 50
Round

Handle .......................................................... 50
Points ............................................................ 36

Rulers.......................................................................83
S
Save..........................................................................16

Designs.........................................................16
Save As.................................................................... 16
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Scroll Bar
FilmStrip .......................................................57

Select
All....................................................................47
Area................................................................43
Block of Objects.........................................43
Freehand......................................................45
Freehand Point ..........................................46
Multiple Objects................................ 43, 58
None..............................................................47
Object ...........................................................45
Object in FilmStrip....................................58
Objects..........................................................43

Select and Resize Areas.....................................60
Select Area

Drawing Panel............................................43
Selected Objects

Grouping......................................................54
Selection

Deselect........................................................44
Sequence of Objects..........................................58
Shapes

Draw ..............................................................32
Drawing........................................................32
Type ...............................................................32

Shortcuts on the Desktop .................................. 2
Show

Measurements in Preferences ..............79
Show Grid ..............................................................76
Show Measurements In ....................................83
Size

Real ................................................................83
Skew

Block of Objects.........................................49
Smooth

Line ................................................................22
Smoothness

Line ................................................................37
Line Options ...............................................22

Snap
To Grid................................................... 29, 78
To Line...........................................................29

Snap to Line
Edit Points....................................................37

Software Window Parts....................................... 3
Square

Draw ..............................................................32
Handle...........................................................48
Points.............................................................36

Standard
Color Box Tab..............................................20

Standard Appliqué .............................................74
Start Menu............................................................... 2
Starting PREMIER+ ECQ ...................................... 2
Status Bar ....................................................... 5, 101
Straight

Line ................................................................23
Style .........................................................................33
Styles .......................................................................83
Surround Color.....................................................83
Swap Colors...........................................................19
T
Tack and Trim........................................................74
Technical Information.......................................... 1
Terms and Conventions ...................................... 6

Text Box ..................................................................33
Thread Range

Export ........................................................... 84
Tile .....................................................................63, 93
Title Bar................................................................ 3, 5
Toolbar

Quick Access.............................................101
Toolbars................................................................101
Tools

Alignment....................................................53
Editing .......................................................... 36

Top
Align ..............................................................54

Trace Area ..............................................................30
Trace Area & Hole................................................ 31
Trace Line...............................................................29
Transform...............................................................51
Triangular Handle ...............................................50
Troubleshooting.................................................. 86
Type

Shapes .......................................................... 32
Type of Object......................................................57
U
Uncombine ........................................................... 59
Undo........................................................................61
Undo and Redo....................................................61
Ungroup.................................................................56

All.................................................................... 57
Update

Check for......................................................85
User’s Guide .............................................................1
Utilities.................................................................... 85
V
Vertical .............................................................63, 93

Alignment....................................................53
Vertical Options ................................................... 93
Vertically

Distribute.....................................................54
Mirror Block ................................................ 50

Very Smooth
Line ................................................................22

View
Pictures and Designs ............................... 76

View Tab .................................................................96
Visible Object

First ................................................................58
W
Wheel Mouse Zoom...........................................80
Where to Start .........................................................2
Window

Parts..................................................................3
Picture..............................................................4

Windows® Explorer.............................................15
Z
Zoom

Bar ..................................................................81
Commands.................................................. 80
Mouse Wheel..............................................80

Zoom by Percentage ......................................... 81
Zoom Commands.............................................101
Zoom In ..................................................................80
Zoom Out ..............................................................80
Zoom To Canvas .................................................. 81
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Zoom to Designs .................................................81
Zoom To Rectangle.............................................80
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